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Preface

This guide provides instructions on how to install the 
ApplicationXtender Desktop (AppXtender Desktop) software.

As part of an effort to improve and enhance the performance and capabilities 
of its product line, EMC from time to time releases revisions of its hardware 
and software. Therefore, some functions described in this ApplicationXtender 
Desktop Installation Guide may not be supported by all revisions of the 
software or hardware currently in use. For the most up-to-date information 
on product features, refer to your product release notes. If a product does not 
function properly or does not function as described in this ApplicationXtender 
Desktop Installation Guide, please contact your EMC representative.

Audience The information in this guide is intended for system administrators 
who are responsible for installing software and maintaining the 
servers and clients on a network. Operators who monitor the daily 
backups may also find this manual useful.
ApplicationXtender Desktop Installation Guide vii
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Organization Here is a list of where information is located in this guide.

Related
Documentation

After installing the AppXtender Desktop software, refer to the 
ApplicationXtender Desktop User’s Guide, the ApplicationXtender Image 
Capture User’s Guide, and the program’s Online Help for detailed 
instructions on how to use the AppXtender Desktop software.

Post-release information is contained in the Release Supplement for 
this product. This document is available by clicking the Product 
Documentation link at customernet.documentum.com. Refer to the web 
site periodically to view the latest Release Supplement. You must 
have a Technical Support account to access the product 
documentation on this site. If you do not already have a Technical 
Support account, request one at support. 
documentum.com/support/access/dmRegistration.asp.

Related documents include:

◆ ApplicationXtender Concepts Guide

◆ ApplicationXtender Core Components Administrator’s Guide

◆ ApplicationXtender Administrator’s Quick Reference

◆ ApplicationXtender Desktop User’s Guide

◆ ApplicationXtender Desktop User’s Quick Reference

◆ ApplicationXtender Image Capture User’s Guide 

◆ ApplicationXtender Image Capture User’s Quick Reference 

◆ ApplicationXtender Technical Product Overview

Most of these documents can be found in the Documentation 
directory on the product CD-ROM. All documents are in Adobe 

Table 1 Guide Summary

Title Description

Chapter 1, Installing ApplicationXtender 
Desktop

Explains different methods for installing AppXtender Desktop: 
Using the setup wizard and using Unattended Setup.

Chapter 2, Configuring AppXtender 
Document Manager Workstations

Explains all of the configuration options available for individual 
AppXtender Document Manager workstations. It also describes 
how the Save/Load Settings feature can be used to copy 
AppXtender Document Manager configuration settings from one 
workstation to one or more other workstations. 

Appendix A, Maintaining the 
AppXtender Desktop Installation

Explains how to modify, repair, or remove an AppXtender Desktop 
installation.
ApplicationXtender Desktop Installation Guide
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Acrobat Portable Document Format (PDF), and can be viewed by 
downloading and installing the Adobe Acrobat Reader. The Reader is 
available on the EMC® AppXtender Desktop/Web CD-ROM, or 
directly from Adobe at www.adobe.com. To install and use the Reader 
on the preferred platform, refer to the instructions on the Adobe web 
site.

Conventions Used in
This Guide

EMC uses the following conventions for notes, cautions, warnings, 
and danger notices.

A note presents information that is important, but not hazard-related.

CAUTION!
A caution contains information essential to avoid data loss or 
damage to the system or equipment. The caution may apply to 
hardware or software.

Typographical Conventions
EMC uses the following type style conventions in this guide:

AVANT GARDE Keystrokes

Palatino,
bold

◆ Dialog box, button, icon, and menu items in text
◆ Selections you can make from the user interface, 

including buttons, icons, options, and field 
names

Palatino,
italic

◆ New terms or unique word usage in text 
◆ Command line arguments when used in text
◆ Book titles
ApplicationXtender Desktop Installation Guide ix
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Where to Get Help For questions about technical support, call your local sales office or 
service provider.

If you have a valid EMC service contract, contact EMC Customer 
Support at:

*Please see dialing instructions on the EMC Website at:

http://customernet.documentum.com/support/access_numbers.htm

Follow the voice menu prompts to open a service call and select the 
applicable product support.

Courier, 
italic

Arguments used in examples of command line 
syntax.

Courier System prompts and displays and specific 
filenames or complete paths. For example:

working root directory [/user/emc]:

c:\Program Files\EMC\Symapi\db

Courier, 
bold 

◆ User entry. For example:
symmpoll -p

◆ Options in command line syntax

North America, 
Canada, and 
Latin America:

1-877-534-2867

Europe, Middle 
East, and 
Africa:

+800-EMC2-EMC2 
(+800-3622-3622)*

Asia Pacific and 
Japan:

+800-EMC2-EMC2 (+800-3622-3622)
ApplicationXtender Desktop Installation Guide
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1

Installing
ApplicationXtender

Desktop

ApplicationXtender Desktop (AppXtender Desktop) Setup can be 
customized for your particular installation scenario. You can choose 
to install AppXtender Desktop using two different methods. For 
more information, see the following sections: 

◆ Third-party Components Required Before Setup .........................1-2
◆ Setup Wizard ......................................................................................1-6
◆ Unattended Setup ............................................................................1-17
◆ Configuration Overview.................................................................1-24

CAUTION!
If you are upgrading an existing ApplicationXtender system, you 
must begin the upgrade with the procedure in the 
ApplicationXtender Core Components Administrator’s Guide. 
Installing ApplicationXtender Desktop 1-1
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Third-party Components Required Before Setup
The following third-party components are not automatically installed 
during the AppXtender Desktop installation process: 

◆ If you are running Windows 98 SE, Windows ME, or Windows 
2000, you might not have Microsoft Windows Installer (MSI) 2.0 
installed. MSI 2.0 must be installed prior to running the 
AppXtender Desktop setup wizard or an Unattended Setup. For 
instructions on installing MSI 2.0, see Installing Microsoft Windows 
Installer on page 1-2.

◆ If you are installing AppXtender Desktop on a workstation on 
which user or group lists will be imported in ApplicationXtender 
Application Generator (AppXtender AppGen), the workstation 
must have Active Directory Services (ADS) 2.5. If you are running 
Windows 98 SE or Windows ME, you might not have ADS 2.5 
installed. For instructions on installing ADS 2.5, see Installing 
Active Directory Services on page 1-3. 

◆ If you are installing AppXtender Desktop with 
AppXtenderDEMO (the AppXtender demonstration database), 
the computer must have the Microsoft Jet 4.0 OLE DB Provider 
installed. All supported operating systems except Windows 98 SE 
include this provider. If you are installing AppXtenderDEMO on 
a Windows 98 SE computer, you may need to install this provider. 
For instructions on installing this provider, see Installing Microsoft 
Jet 4.0 OLE DB Provider on page 1-4. 

◆ If you are installing AppXtender Desktop on a workstation which 
will be used to run the AppXtender Index Server, the workstation 
must have Internet Explorer 5 or later. 

Installing Microsoft 
Windows Installer

If you are running Windows 98 SE, Windows ME, or Windows 2000, 
you might not have Microsoft Windows Installer (MSI) 2.0 installed. 
MSI 2.0 must be installed prior to running the AppXtender Desktop 
setup wizard or an Unattended Setup.
ApplicationXtender Desktop Installation Guide
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To install MSI 2.0: 

1. Close all open applications.

2. Obtain the installation files for AppXtender Desktop third-party 
components. You have the following choices:

• Download the ThirdPartyComponents_5.30.xxx.zip file 
from one of the following locations to a temporary directory 
on your computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. In the temporary directory or CD-ROM drive, navigate to the 
Third Party Components\Microsoft Installer 2.0 directory 
and run one of the following files: 

• If you are installing to a Windows 98 SE or Windows ME 
computer, run INSTMSI.EXE.

• Otherwise, run INSTMSIW.EXE.

Windows Installer Setup begins. When the installation is 
complete, the Windows Installer message appears indicating that 
setup has completed successfully. 

4. Click OK.

5. When setup is complete, you may be required to restart your 
computer. Be sure to restart your computer if prompted. 

Installing Active 
Directory Services

If you are installing AppXtender Desktop on a workstation on which 
user lists will be imported in AppXtender AppGen for security, the 
workstation must have Active Directory Services (ADS) 2.5. If you are 
Third-party Components Required Before Setup 1-3
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running Windows 98 SE or Windows ME, you might not have ADS 
2.5 installed. Use the following steps to install ADS 2.5.

To install ADS: 

1. Close all open applications.

2. Obtain the installation files for AppXtender Desktop third-party 
components. You have the following choices:

• Download the ThirdPartyComponents_5.30.xxx.zip file 
from one of the following locations to a temporary directory 
on your computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. In the temporary directory or CD-ROM drive, navigate to the 
Third Party Components\Active Directory Services 2.5 
directory and run one of the following files: 

• If you are installing to a Windows 98 SE computer, run 
ADS98.EXE.

• Otherwise, run ADS.EXE.

The Active Directory Service Interfaces Version 2.5 message 
appears, asking if you want to install ADS. 

4. Click Yes. The Active Directory Service Interfaces Version 2.5 
license agreement appears.

5. Click Yes. A message appears indicating that the installation is 
done. 

6. Click OK.

Installing Microsoft 
Jet 4.0 OLE DB 
Provider

If you are installing AppXtender Desktop with AppXtenderDEMO 
(the AppXtender demonstration database), the computer must have 
the Microsoft Jet 4.0 OLE DB Provider installed. All supported 
operating systems except Windows 98 SE include this provider. If you 
ApplicationXtender Desktop Installation Guide
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are installing AppXtenderDEMO on a Windows 98 SE computer, you 
may need to install this provider. 

To install the Microsoft Jet 4.0 OLE DB Provider: 

1. Close all open applications.

2. Obtain the installation files for AppXtender Desktop third-party 
components. You have the following choices:

• Download the ThirdPartyComponents_5.30.xxx.zip file 
from one of the following locations to a temporary directory 
on your computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. In the temporary directory or CD-ROM drive, navigate to the 
Third Party Components\Microsoft Jet 4.0 directory and 
run one of the following files: 

• If you are installing to a Windows 98 SE computer, run 
Jet40SP7_9xNT.exe.

• If you are installing to a Windows ME computer, run 
Jet40SP7_WMe.exe.

• If you are installing to a Windows XP computer, run 
WindowsXP-KB829558-x86-ENU.exe.

• If you are installing to a Windows 2000 computer, run 
Windows2000-KB829558-x86-ENU.exe.

• If you are installing to a Windows 2003 computer, run 
WindowsServer2003-KB829558-x86-ENU.exe.

Setup begins. When the installation is complete, a message 
appears indicating that setup has completed successfully. 

4. Click OK.

5. When setup is complete, you may be required to restart your 
computer. Be sure to restart your computer if prompted. 
Third-party Components Required Before Setup 1-5
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Setup Wizard
The ApplicationXtender Desktop (AppXtender Desktop) installation 
process follows standard Windows setup wizard rules, with prompts 
that guide you through the installation process. 

Within the setup wizard, the Next button allows you to proceed to 
the next page, while the Back button allows you to return to the 
previous page. You can cancel the installation by clicking Cancel. For 
detailed procedures, follow the instructions contained in each of the 
following sections: 

◆ Starting Setup on page 1-7

◆ Product Conflict Page on page 1-8

◆ Welcome Page on page 1-8

◆ License Agreement Page on page 1-8

◆ Destination Folder Page on page 1-9

◆ Select Installation Type Page on page 1-10

◆ Select Features Page on page 1-12

◆ Completing the Installation on page 1-15

Although a full AppXtender Desktop installation requires up to 497 
MB of hard disk space (depending on your operating system), you 
can also choose which components you would like to install to 
minimize hard disk usage. 
ApplicationXtender Desktop Installation Guide
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Starting Setup This procedure allows you to begin the setup process.

These installation instructions apply only to the English release of 
AppXtender Desktop. For instructions on installing releases of AppXtender 
Desktop for other languages, refer to the ApplicationXtender Release 
Supplement for that language.

To begin the setup process: 

1. Close all open applications.

2. Obtain the installation files for AppXtender Desktop. You have 
the following choices:

• Download the Desktop_5.30.xxx.zip file from one of the 
following locations to a temporary directory on your 
computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. In the temporary directory or CD-ROM drive, navigate to the 
AppXtender Desktop directory and run Setup.exe. The 
AppXtender Desktop setup wizard appears. 

If a previous release of AppXtender or another Content Management 
product exists on the workstation, the first page of the wizard allows 
you to uninstall the previous release. For information, see Product 
Conflict Page on page 1-8. Otherwise, the Welcome page appears. For 
information, see Welcome Page on page 1-8. 
Setup Wizard 1-7
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Product Conflict 
Page

The Product Conflict page allows you to uninstall previous releases. 

Figure 1-1 AppXtender Setup Wizard - Product Conflict Page

To continue the setup process: 

1. Click Remove All.

2. When all conflicting products have been uninstalled, the Next 
button becomes available. Click Next. The Welcome page 
appears. For information, see Welcome Page on page 1-8.

Welcome Page The AppXtender Desktop setup wizard Welcome page introduces the 
setup process. 

To continue the setup process: 

◆ Click Next. The License Agreement page appears. For 
instructions, see License Agreement Page on page 1-8.

License Agreement 
Page

The License Agreement page allows you to read and accept the 
software license agreement. 
ApplicationXtender Desktop Installation Guide
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Figure 1-2 AppXtender Desktop Setup Wizard - License Agreement Page

To continue the setup process: 

1. Read the License Agreement.

2. After reading the License Agreement, you have the following 
choices: 

• Enable the I accept the license agreement option. The Next 
button becomes available. Click Next. The Destination Folder 
page appears. For instructions, see Destination Folder Page on 
page 1-9.

• Enable the I do not accept the license agreement option. If you 
do not accept the terms of the License Agreement, you must 
click Cancel to terminate the installation.

Destination Folder 
Page

The Destination Folder page allows you to customize the 
AppXtender Desktop installation directory (the destination folder). 
By default, AppXtender Desktop installs to C:\Program 
Files\XtenderSolutions\Content Management, but you can 
change the destination folder from this page. 
Setup Wizard 1-9
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Figure 1-3 AppXtender Desktop Setup Wizard - Destination Folder Page

If AppXtender Desktop setup detects any AppXtender component already 
installed on the workstation, the setup wizard allows only one AppXtender 
Desktop destination directory: the directory in which the other AppXtender 
component is installed. To continue the setup process, click Next. 

To continue the setup process: 

◆ If no other AppXtender Desktop Content Management products 
are detected on the workstation, you have the following choices: 

• If the destination folder listed in the Destination Folder box is 
the one you want to use, click Next. 

• If the destination folder listed in the Destination Folder box is 
not the one you want to use, click Browse and choose the 
directory you would like to use. Click OK to return to the 
Destination Folder page. Click Next. 

The Select Installation Type page appears. For instructions, see Select 
Installation Type Page on page 1-10.

Select Installation 
Type Page

The Select Installation Type page allows you to choose the type of 
workstation installation you need. You can choose a Retrieval 
workstation type (which installs all components necessary for 
document retrieval), a Scanning workstation type (which installs all 
components necessary for scanning), or an Administrator 
workstation type (which installs all components necessary for 
ApplicationXtender Desktop Installation Guide
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AppXtender administration). If you prefer to select which 
components to install, this page allows you to perform a custom 
installation. 

Figure 1-4 AppXtender Desktop Setup Wizard - Select Installation Type Page

To continue the setup process: 

1. Select the type of AppXtender Desktop installation that you want 
to use. You can install a Retrieval, Scanning, or Administrator 
workstation type, or you can select Custom to customize your 
installation. For information on each of the workstation types, 
refer to the "Workstation Types" section of the ApplicationXtender 
Concepts and Planning Guide. 

If you select the Scanning workstation type, you must install the 
appropriate drivers prior to scanning documents in AppXtender 
Document Manager or Image Capture. For more information, see 
Installing Scanner Drivers on page 1-24.

2. Click Next. The page that appears next depends on the type of 
installation you choose: 

• If you chose the Administrator installation type, the Select 
Administrator Installation Type page appears. For 
instructions, refer to the ApplicationXtender Core Components 
Guide or the ApplicationXtender Index Server Administrator’s 
Guide. 
Setup Wizard 1-11



1

1-12

Installing ApplicationXtender Desktop

AXIG.book  Page 12  Monday, December 5, 2005  12:43 PM
• If you chose the Custom installation type, the Select Features 
page appears. For instructions, see Select Features Page on 
page 1-12.

• If you chose the Retrieval or Scanning installation type, the 
Ready to Install the Application page appears. For 
instructions, see Completing the Installation on page 1-15.

Select Features 
Page

The Select Features page allows you to include or exclude 
components from the installation. 

Figure 1-5 AppXtender Desktop Setup Wizard - Select Features Page

The Select Features page lists available components in a tree. The 
following table describes each of the available components: 

Table 1-1 AppXtender Desktop Components

Component Description

Administrator 
Configuration

ApplicationXtender 
Administrator 

Installs the ApplicationXtender Administrator (AppXtender Admin), which 
allows the AppXtender system administrator to configure data sources, 
licensing, and other settings for AppXtender content management products.

ApplicationXtender User 
Profile Administrator 

Installs the ApplicationXtender User Profile Administrator (AppXtender User 
Profile Admin), which can be used to manage AppXtender Web user profiles 
from a central location. 
ApplicationXtender Desktop Installation Guide
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Administrator Utilities

ApplicationXtender Archive 
Wizard

Installs the AppXtender Archive component, allowing administrators to archive 
infrequently accessed documents.

ApplicationXtender Full Text 
Index Wizard

Installs AppXtender Full Text Index, allowing administrators to submit 
documents to the AppXtender Index Server for full-text indexing. This wizard 
allows administrators to submit more documents at a time than the 
AppXtender Desktop result set allows. 

Import Utilities Installs the AppXtender Index Image Import, Auto Index Import, and Key 
Reference Import wizards. All three allow administrators to import index 
information. The AppXtender Index Image Import wizard allows administrators 
to import indexed AppXtender documents.

ApplicationXtender 
Migration Wizard

Installs the AppXtender Migration component, allowing administrators to 
migrate applications from one AppXtender data source to another.

ApplicationXtender Move 
Online

Installs the AppXtender Move Online component, allowing administrators to 
move scanned documents from a local scan storage area to an application’s 
primary document write path.

ApplicationXtender Queue 
Manager

Installs the AppXtender Queue Manager component, allowing administrators 
to manage AppXtender data sources and AppXtender Index Server 
processing queues.

ApplicationXtender Records 
Manager Administrator 

Installs the ApplicationXtender Records Manager Administrator (AppXtender 
RM Admin), which allows administrators to set retention modes for 
AppXtender applications.

ApplicationXtender 
Application Generator

Installs the AppXtender AppGen component, allowing administrators to 
configure and manage AppXtender applications, security, and licensing. 

ApplicationXtender 
Document Manager

Installs the AppXtender Document Manager application, allowing users to 
create, retrieve, and manage documents.

ApplicationXtender Index 
Server

Installs the AppXtender Index Server component, allowing administrators to 
submit documents to a full-text database. 

Verity K2 for 
ApplicationXtender 
Gateway 

Installs the Verity K2 for ApplicationXtender Gateway (Verity for AppXtender 
Gateway), allowing administrators to configure the use of the Verity K2 Server 
as the full-text indexing engine. 

ApplicationXtender 
Scanner Support

Installs Scanner Support components, allowing users to scan in new 
documents and batches. BUIC, Contex, ISIS, Kofax, TWAIN\WIA, and/or Vidar 
support can be installed. 

Table 1-1 AppXtender Desktop Components (continued)

Component Description
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The following procedure describes how to include or exclude 
components from the AppXtender Desktop installation. 

To include or exclude AppXtender Desktop components: 

1. Decide which features (components) you want to include or 
exclude. 

2. For each component that you want to include, click the disk icon 
located next to the component. A menu appears, providing 
installation options. From the menu, select Will be installed on the 
local hard drive. 

3. For each component that you want to exclude, click the disk icon 
located next to the component and select Entire feature will be 
unavailable.

4. If, after changing components to be installed, you would like to 
reset the components to their defaults, click Reset.

5. If you want to know how much space is required for the specific 
installation you have selected, click Disk Cost. A dialog box 
appears displaying each drive of the workstation where 
AppXtender Desktop will be installed, its available disk space, 

ApplicationXtender Image 
Capture

Installs the AppXtender Image Capture component, allowing users to create 
batches. One copy of AppXtender Image Capture is provided free of charge for 
any network purchase of AppXtender Desktop. If you need AppXtender Image 
Capture on more than one workstation, you must purchase additional copies.

Demo Database Installs a sample database (demonstration database files, demonstration 
application image files, and the AppXtenderDEMO data source). 

Third Party Components

ABBYY FineReader 6.0 
engine

Installs the ABBYY FineReader 6.0 engine, allowing users to perform OCR. 

Adobe PDF Library 6.0 Installs Adobe PDF Library 6.0, allowing users to view, print, endorse, full-text 
index, and annotate PDF files in AppXtender Desktop. 

Microsoft Data Access 
Components 2.8

Installs Microsoft Data Access Components (MDAC) 2.8 unless a higher 
version already exists. MDAC allows administrators to create AppXtender data 
sources. 

Verity KeyView 9.1 Installs Verity KeyView 9.1, allowing users to view the content of some foreign 
files in AppXtender Desktop. 

Table 1-1 AppXtender Desktop Components (continued)

Component Description
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and the amount required for the installation. If there is not 
enough space available on the drive where you are trying to 
install AppXtender Desktop, it will be highlighted in this dialog 
box. 

Figure 1-6 AppXtender Desktop Setup Disk Cost Dialog Box

In the disk cost dialog box, click OK.

6. After you have configured which components you would like to 
install, click Next. 

The AppXtender Desktop setup wizard checks for the existence of 
Microsoft .NET Framework on the computer. If it is not already 
installed, Read to Install the Microsoft .NET Framework page 
appears. If this page appears, click Next and follow the prompts. 
When setup is complete, you may be required to restart your 
computer. Be sure to restart your computer if prompted. Then if 
necessary, restart the AppXtender Desktop setup wizard as 
described in Starting Setup on page 1-7. 

The Ready to Install the Application page appears. For 
instructions, see Completing the Installation on page 1-15.

Completing the 
Installation

The Ready to Install the Application page allows you to complete the 
installation. 

To complete the installation: 

1. Click Next. AppXtender Desktop begins installing the 
components you selected. The Updating System page indicates 
the progress of the installation.

2. Wait for AppXtender Desktop to finish the installation process. 
This may take several minutes. The Finished page appears, 
indicating a successful installation. 
Setup Wizard 1-15
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3. Click Finish. If you must restart your computer, a message 
prompting you to do so appears. 

Figure 1-7 Installer Information Restart System Message

4. You have the following choices: 

• To restart your system now, click Yes.

• To close AppXtender Desktop Setup without restarting your 
system, click No. 

It is highly recommended that you restart your system when prompted 
to do so by AppXtender Desktop. Otherwise, conflicts may occur.
ApplicationXtender Desktop Installation Guide
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Unattended Setup
With an ApplicationXtender Desktop (AppXtender Desktop) 
Unattended Setup, you can ensure that AppXtender Desktop is 
installed consistently on multiple workstations. An Unattended 
Setup can perform an installation using the Windows command line.

Unattended Setup is provided for administrators who: 

◆ Are familiar with the AppXtender Desktop installation process.

◆ Are installing AppXtender Desktop on workstations that already 
have all of the required third-party components.

◆ Do not need to perform a custom installation.

◆ Do not need to upgrade an installation. 

To perform an Unattended Setup: 

1. Install all required third-party components. For instructions, see 
Installing Third-Party Components on page 1-17.

2. Compose a command line to install AppXtender Desktop 
unattended, according to your needs. For instructions, see 
Unattended Setup Command Line Syntax on page 1-18.

3. Run unattended setup from the Windows command prompt. For 
instructions, see Running Unattended Setup from the Command Line 
on page 1-22.

Installing Third-Party 
Components

The following table lists operating systems and the components that 
may need to be installed on each. 

Table 1-2 Third-Party Components List

Operating System Components that must be installed

Windows 98 SE Common Control
MSI 2.0
Windows HTML Help
ADS 2.5

Windows ME MSI 2.0
ADS 2.5
Unattended Setup 1-17
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The following sections provide information about installing MSI and 
ADS before running an Unattended Setup: 

◆ Installing Microsoft Windows Installer on page 1-2

◆ Installing Active Directory Services on page 1-3 (necessary only if 
you are installing AppXtender Desktop on a workstation on 
which user lists will be imported in AppXtender AppGen for 
Content Management security)

If you are installing AppXtender Desktop on a workstation that will 
be used to run the AppXtender Index Server, the workstation must 
have Internet Explorer 5 or later. 

Unattended Setup 
Command Line 
Syntax

Unattended Setup is run using MSIExec (Microsoft Windows 
Installer) from the Windows command line. An option is available for 
each configurable installation parameter. 

A Windows command line would appear as follows: 

MsiExec.exe /I ApplicationXtender.msi /Q INSTALLMODE=# 
INSTALLDIR=“Path” /L “log_path_&_filename”

The following table describes each parameter of these command 
lines: 

Windows XP 

Windows 2000 MSI 2.0

Windows 2003

Table 1-2 Third-Party Components List (continued)

Operating System Components that must be installed

Table 1-3 Unattended Setup Command Line Syntax

Parameter Windows Command Line

MsiExec.exe This parameter calls the Microsoft Windows Installer application (mandatory 
parameter). 

/I ApplicationXtender.msi This parameter must follow MsiExec.exe (mandatory parameter). 

/Q This parameter indicates that no user interface (UI) will be visible (mandatory 
parameter for true unattended setup).
ApplicationXtender Desktop Installation Guide
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Paths and filenames should be surrounded by quotation marks.

For sample Unattended Setup command lines, see Sample Unattended 
Setup Command Lines on page 1-22.

Installation Mode Four installation types are available using AppXtender Desktop 
Unattended Setup. To designate an installation type, use the 
INSTALLMODE command with the appropriate installation mode 
number. 

INSTALLMODE is a mandatory parameter for AppXtender Desktop 
Unattended Setup command line syntax.

The following table lists the installation modes (components or 
component groupings) available during AppXtender Desktop 
Unattended Setup: 

INSTALLMODE This parameter establishes which components will be installed (mandatory parameter, 
requires /Q). No spaces should be placed between INSTALLMODE, the = sign, 
and the installation mode number. For a list of the available installation modes, see 
Installation Mode on page 1-19. 

INSTALLDIR This parameter designates an installation path other than the AppXtender Desktop 
default directory of C:\Program 
Files\XtenderSolutions\Content Management (optional). No 
spaces should be placed between INSTALLDIR, the = sign, and the installation 
directory. For a discussion of this command, see Installation Directories on page 1-21.

/L This parameter designates the log path and filename (optional). The directory that you 
specify must already exist.

Table 1-3 Unattended Setup Command Line Syntax (continued)

Parameter Windows Command Line

Table 1-4 Installation Modes Available During Unattended Setup

Usage

AppXtender 
Document 
Manager

AppXtender 
Scanner 
Support

Administrator 
Utilities

AppXtender 
AppGen

AppXtender 
Index 
Server

Administrator 
Configuration

Demo 
Database

INSTALLMODE=1 √

INSTALLMODE=2 √ √

INSTALLMODE=3 √ √ √

INSTALLMODE=4 √ √ √
Unattended Setup 1-19
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CAUTION!
Do not place spaces between the INSTALLMODE command and 
the equal sign, or between the equal sign and workstation code. If 
spaces are included, the command fails.

INSTALLMODE=5 √ √ √ √

INSTALLMODE=6 √

INSTALLMODE=7 √ √ √ √

INSTALLMODE=8 √ √ √ √

INSTALLMODE=9 √ √ √ √ √

INSTALLMODE=10 √

INSTALLMODE=11 √ √ √ √

INSTALLMODE=12 √ √ √ √

INSTALLMODE=13 √ √ √ √ √

INSTALLMODE=14 √ √

INSTALLMODE=15 √ √ √ √ √

INSTALLMODE=16 √ √ √ √ √

INSTALLMODE=17 √ √ √ √ √ √

INSTALLMODE=18 √ √ √ √ √ √ √

Table 1-4 Installation Modes Available During Unattended Setup (continued)

Usage

AppXtender 
Document 
Manager

AppXtender 
Scanner 
Support

Administrator 
Utilities

AppXtender 
AppGen

AppXtender 
Index 
Server

Administrator 
Configuration

Demo 
Database
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The following table lists the components for each INSTALLMODE 
component grouping:

Installation Directories AppXtender Desktop Setup installs to the C:\Program 
Files\XtenderSolutions\Content Management directory by 
default. To change the default directory, use the INSTALLDIR 
command.

The format for the INSTALLDIR command is as follows: 

INSTALLDIR=“D:\AppXtender Desktop”

where D:\AppXtender Desktop is the drive and directory where you 
would like to install AppXtender Desktop. 

Table 1-5 Components Included in each INSTALLMODE Component Grouping

Component Grouping Components Included

AppXtender Document Manager AppXtender Document Manager

AppXtender Scanner Support AppXtender Image Capture
BUIC Support
Contex Support
ISIS Support
Kofax Support
TWAIN WIA Support
Vidar Support

Administrator Utilities AppXtender Archive
AppXtender Full Text Index
AppXtender Auto Index Import
AppXtender Index Image Import
AppXtender Key Reference Import
AppXtender Migration
AppXtender Move Online
AppXtender Queue Manager
AppXtender RM Admin

AppXtender AppGen AppXtender AppGen

AppXtender Index Server AppXtender Index Server
Verity for AppXtender Gateway

Administrator Configuration AppXtender Admin 
AppXtender User Profile Admin

Demo Database Demo Database
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CAUTION!
Do not place spaces between the INSTALLDIR command and the 
equal sign, or between the equal sign and the installation directory. 
If spaces are included, the command does not work. In addition, 
you should always surround paths with quotation marks.

If you want to install AppXtender Desktop to the default directory of 
C:\Program Files\XtenderSolutions\Content Management, do 
not use the INSTALLDIR command.

Sample Unattended
Setup Command Lines

Two sample command lines follow. They show possible combinations 
of command line syntax that can be used to install AppXtender 
Desktop via Unattended Setup.

Unattended Setup Command Line Syntax - Sample One
MsiExec.exe /I ApplicationXtender.msi /Q INSTALLMODE=18 

INSTALLDIR=“D:\AppXtender Desktop” /L “C:\AxSetup.log”

All AppXtender Desktop components, including the Demo database, 
will be installed from the AppXtender Desktop Setup file. 
AppXtender Desktop will be installed at D:\AppXtender Desktop. 
No user interface will appear, and events are saved to the 
AxSetup.log file. 

Unattended Setup Command Line Syntax - Sample Two
MsiExec.exe /I ApplicationXtender.msi /Q INSTALLMODE=1 /L 

“C:\AxSetup.log” /Q

Retrieval workstation components will be installed from the 
AppXtender Desktop Setup file. AppXtender Desktop will be 
installed to the default directory of C:\Program 
Files\XtenderSolutions\Content Management. No user interface 
will appear. Error messages will be appended to the log file located at 
C:\AxSetup.log.

Running 
Unattended Setup 
from the Command 
Line

Once you have composed your command line, you can run 
Unattended Setup from the command line.
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CAUTION!
Be sure to close all applications and save work in other applications 
before running Unattended Setup. If the computer needs to restart, 
it does so automatically.

To run Unattended Setup from the command line: 

1. Close all open applications.

2. Obtain the installation files for AppXtender Desktop. You have 
the following choices:

• Download the Desktop_5.30.xxx.zip file from one of the 
following locations to a temporary directory on your 
computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. From the Windows Start menu, select Run. The Windows Run 
dialog box appears. 

• If you are a Windows 98 SE or Windows ME user, type 
command into the Open text box and click OK.

• If you are a Windows 2000 user, type cmd into the Open text 
box and click OK.

4. The Windows command prompt appears.

5. Navigate to the AppXtender Desktop directory in the temporary 
directory or CD-ROM drive. 

6. Enter an Unattended Setup command line. (For instructions on 
composing an Unattended Setup command line, see Unattended 
Setup Command Line Syntax on page 1-18. For command line 
samples, see Sample Unattended Setup Command Lines on 
page 1-22.)

7. Press Enter. 
Unattended Setup 1-23
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Configuration Overview
After you finish installing ApplicationXtender Desktop (AppXtender 
Desktop), consider each of the following: 

◆ Configuring the Data Source on page 1-24

◆ Installing Scanner Drivers on page 1-24

◆ Using the Demo Database on page 1-25

Configuring the 
Data Source

After you have installed AppXtender Desktop, you must configure 
the data source. To configure the data source, use ApplicationXtender 
Administrator (AppXtender Admin) and ApplicationXtender 
Application Generator (AppXtender AppGen). For more information, 
refer to the ApplicationXtender Core Components Administrator’s Guide.

After you have configured one or more data sources, you can use the 
AppXtender Data Source Selector to locate and select the data sources 
that have been created in AppXtender Admin. For information on 
using the AppXtender Data Source Selector, refer to the 
ApplicationXtender Desktop User’s Guide.

CAUTION!
All of the settings that you enter in the AppXtender Admin or Data 
Source Selector are stored in C:\Documents and Settings\All 
Users\Application Data\XSCM.CONFIG. Do not edit the contents 
of the XSCM.CONFIG file. 

Installing Scanner 
Drivers

If you selected a scanner workstation type, you must install the 
appropriate drivers prior to scanning documents in AppXtender 
Document Manager or Image Capture. The AppXtender Desktop 
setup wizard installs the scanner support files only. Scanner drivers 
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are not shipped or installed with AppXtender Desktop, and must be 
installed separately.

Using the Demo 
Database

The Demo database is provided as an optional tool for new 
AppXtender users. The Demo database consists of the demonstration 
database files (such as AXDEMODB.MDB), the demonstration 
application image files, and the AppXtenderDEMO data source. The 
AppXtenderDEMO data source refers to a self-contained Microsoft 
Access database that allows you to perform various functions 
without affecting the actual system. 

The demonstration applications (CHECKS, COLDAPP, CONADMIN, 
COUNTY, DOCS, HR, IMAGEAPP, MEDICAL, _FORMS, and 
_RSTAMP) have already been created. Directions on how to create 
new applications are provided in the ApplicationXtender Core 
Components Administrator’s Guide or in AppXtender AppGen Online 
Help.

Table 1-6 Scanner Drivers

AppXtender-supported Scanner Components You Need to Install

Kofax-supported Scanners • Kofax scanner support files (in AppXtender Desktop setup)
• Kofax Image Controls (distributed with your Kofax card) 

TWAIN-supported Scanners • TWAIN scanner support files (in AppXtender Desktop setup) 
• TWAIN driver for your particular scanner (distributed with most 

scanners)

ISIS-supported Scanners • ISIS scanner support files (in AppXtender Desktop setup) 
• ISIS driver for your particular scanner

Contact technical support or your hardware provider for an ISIS 
scanner driver.

Vidar Scanners • Vidar scanner support files (in AppXtender Desktop setup) 
• Vidar driver 

Contex Scanners • Contex scanner support files (in AppXtender Desktop setup) 
• Contex driver 

BUIC Scanners • BUIC scanner support files (in AppXtender Desktop setup) 
• BUIC driver
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Your login procedure may vary depending on whether you have logged in 
before and depending on the security provider in use for the current data 
source. For information, see Variations on Login Procedures on page 1-28. 

To use the Demo database: 

1. From the Windows Start menu, select Programs > 
ApplicationXtender Desktop > AppXtender Data Source Selector. 
The AppXtender Data Source Selector appears, listing installed 
AppXtender data sources.

The AppXtenderDEMO data source appears in this list only if you 
selected the Custom installation type and chose to install the 
AppXtender Desktop Demo Database from the Select Features page of 
the Setup Wizard during the installation process (or if you chose an 
installation mode with Demo Database using INSTALLMODE=18 
during Unattended Setup). For information about installing the Demo 
Database component, see Select Features Page on page 1-12.

Figure 1-8 AppXtender Data Source Selector

2. Double-click AppXtenderDEMO to set it as default, or select 
AppXtenderDEMO and click Set as Default. 

3. Click OK. The AppXtender Data Source Selector closes.

4. From the Windows Start menu, select Programs > 
ApplicationXtender Desktop > AppXtender Document Manager. 
The Login dialog box for AppXtender Desktop appears. 
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Figure 1-9 AppXtender Desktop Login Dialog Box

5. In the User Name text box, type a user name that is valid for the 
default data source. 

6. In the Password text box, type the password for the user name 
you entered. 

AppXtender Desktop opens with many applications, such as 
CHECKS, DOCS, and HR, created and populated with 
documents. (If your AppXtender Desktop user account has the 
Administrator privilege, the _FORMS and _RSTAMP applications 
also appear in the application list. These applications allow you to 
configure forms and rubber stamp annotations.) You can execute 
commands such as display and search. Images are already 
attached to documents in the application, so these commands are 
valid. 

For information on how to create documents and perform other 
functions in AppXtender Desktop, refer to AppXtender Desktop 
Online Help or the ApplicationXtender Desktop User’s Guide included 
with the purchase of AppXtender Desktop.
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Variations on Login
Procedures

The variations in login procedures depend on whether you have 
logged in before and depend on the security provider in use for the 
data source. The following table describes each variation:

Table 1-7 Variations in Login Procedures

Variation Description

If this is the first time you 
are logging into a new 
AppXtender Desktop 
system

Use the default user name for the AppXtender system administrator: SYSOP. 
The initial password for the SYSOP user is xscm. 

The SYSOP user account has full privileges and cannot be deleted or 
modified. For security reasons, the password for this account should be 
changed to prevent administrative access by unauthorized users. 

If this is a subsequent login Enter the user name for an administrative account that has been created for 
the selected data source. This user account must have the Administrator 
privilege in AppXtender AppGen.

If the current data source is 
using the CM security 
provider

Passwords are not case-sensitive. 

If the current data source is 
using the Windows security 
provider 

When you attempt to start AppXtender software, your current Windows user 
account is checked for authentication and authorization. Depending on your 
profile, you might be automatically logged into the software without a Login 
dialog box.
If you want the Login dialog box to appear, press [Shift] while you attempt to 
start the software and until the Login dialog box appears. 
You must precede the user name with a domain and a backslash. For 
example, typing CM\axadmin indicates the “axadmin” user on the “CM” 
domain. 

If you do not specify a domain, the result depends on your operating system. 
If you are using Windows 2000, the domain is taken from the currently logged 
on user account. If you are using Windows 98 SE or Windows ME, you will 
not be able to log in.

Passwords are case-sensitive. 
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Figure 1-10 Message Confirming Security Provider Switch

If the current data source is 
using a directory service 
security provider 

Depending on configuration in the LDAP directory service and in AppXtender 
Admin, you may need to specify user account information in multiple parts, 
separated by backslashes (\). The administrator who configures directory 
services in AppXtender Admin should distribute appropriate login instructions. 
For instructions on configuring directory services in AppXtender Admin, refer 
to the ApplicationXtender Core Components Administrator’s Guide.
Passwords are case-sensitive. 

If the security provider for 
the selected data source 
has recently been changed 
in AppXtender Admin

After you click Login, a message appears indicating that the security provider 
for the current data source has been changed in AppXtender Admin. See 
Figure 1-10. Click Yes to complete the security provider switch or No to 
cancel. For more information on security providers, refer to the 
ApplicationXtender Core Components Administrator’s Guide. 

If the Remember Password 
option has been enabled in 
AppXtender Desktop or 
Image Capture

You are automatically logged in using your current user name and the same 
logon type that had been selected the last time.

Table 1-7 Variations in Login Procedures (continued)

Variation Description
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Configuring AppXtender
Document Manager

Workstations

With AppXtender Document Manager, many configuration options 
are available to accommodate individual workstation preferences. 
This chapter describes how to configure these options:

◆ Introduction ........................................................................................2-2
◆ Customizing the AppXtender Document Manager Window .....2-3
◆ Configuring Toolbars, Title Bar, and Status Bar ............................2-4
◆ Customizing AppXtender Document Manager Views ................2-9
◆ Data Sources .....................................................................................2-20
◆ Opening the Configuration Dialog Box........................................2-21
◆ View Tab ............................................................................................2-24
◆ Display Tab .......................................................................................2-28
◆ Fonts Tab ...........................................................................................2-31
◆ Scan Tab .............................................................................................2-35
◆ COLD Tab..........................................................................................2-38
◆ Print Tab ............................................................................................2-41
◆ E-Mail Tab .........................................................................................2-46
◆ Export Tab .........................................................................................2-53
◆ File Types Tab ...................................................................................2-58
◆ Data Tab.............................................................................................2-60
◆ Paths Tab ...........................................................................................2-70
◆ Full Text Tab......................................................................................2-73
◆ OCR Tab.............................................................................................2-76
◆ Fax-in Tab ..........................................................................................2-82
◆ Thumbnail Tab..................................................................................2-84
◆ Document Signing Tab ....................................................................2-86
◆ Workflow Tab....................................................................................2-90
◆ Saving and Loading Settings..........................................................2-91
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Introduction
As the AppXtender system administrator, you must consider the 
following aspects of workstation configuration: 

◆ You (or the user) can adjust the layout of the AppXtender 
Document Manager window and the behavior of the AppXtender 
Document Manager views. You can also customize toolbar 
display and settings. For instructions, see Customizing the 
AppXtender Document Manager Window on page 2-3.

◆ You control the level of access that the users on your AppXtender 
system have to functionality on their AppXtender Document 
Manager workstations. You can allow users to configure all 
aspects of AppXtender Document Manager functionality on their 
individual workstations, or you can restrict configuration rights 
and only allow configuration of options relating to the display of 
information in AppXtender Document Manager. For instructions, 
see Opening the Configuration Dialog Box on page 2-21 and the 
topics for each tab.

◆ To simplify AppXtender system deployment, AppXtender 
Document Manager provides Save Settings and Load Settings 
features that allow you to copy workstation settings from one 
Document Manager workstation to another. You (or the user) 
customize all aspects of an Document Manager workstation 
configuration for a single computer, and then save the settings 
using the Save Settings feature. To copy the saved configuration 
to other workstations, you simply load the saved settings file on 
each workstation, and all of the saved configuration settings are 
applied. By going through each of the configuration and 
customization options described in this chapter, you can set most 
of the options that can be saved as workstation settings. For 
detailed instructions and for a list of the settings that are saved, 
see Saving and Loading Settings on page 2-91.

Information in this chapter about AppXtender Document Manager also 
applies to AppXtender Image Capture, except where noted. 
ApplicationXtender Desktop Installation Guide
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Customizing the AppXtender Document Manager Window
You can set up the AppXtender Document Manager window for your 
users and copy it from one AppXtender Document Manager 
workstation to other AppXtender Document Manager workstations. 
By customizing window settings, you can set up the AppXtender 
environment in the way that you think would be most productive for 
the users on your AppXtender system. You can customize both 
toolbar settings and view settings. Any adjustments that you make to 
the contents, locations, and display settings of the toolbars, and the 
location and display settings of the Application view, Query view, 
Thumbnail view, or AppXtender Workflow Workbox can be copied to 
another AppXtender Document Manager workstation by saving and 
loading settings. For a detailed description of what options are saved, 
see Saving and Loading Settings on page 2-91.

The AppXtender Workflow Workbox view is available only if the 
AppXtender Workflow client (Workbox) is installed on the AppXtender 
Document Manager workstation. The Query view, Thumbnail view, and 
AppXtender Workflow Workbox are not available in AppXtender Image 
Capture. 
Customizing the AppXtender Document Manager Window 2-3
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Configuring Toolbars, Title Bar, and Status Bar
In AppXtender Document Manager, you can customize the toolbars, 
the Document Display or Batch Display view title bar, and the status 
bar to meet your needs. For instructions, see the following topics: 

◆ Displaying or Hiding a Toolbar on page 2-4

◆ Changing the Size of Toolbar Buttons on page 2-5

◆ Customizing Toolbars on page 2-5

◆ Configuring the Title Bar on page 2-6

◆ Displaying or Hiding the Status Bar on page 2-8

The following table briefly describes the functions available on each 
toolbar: 

Displaying or Hiding 
a Toolbar

AppXtender Document Manager toolbars can be shown or hidden 
from view. All AppXtender features are always available from 

Table 2-1 AppXtender Document Manager Toolbars

Toolbar Description

Main The Main toolbar provides shortcuts to common AppXtender commands such as print, 
scan, query, and configure. These commands can be executed by clicking the buttons on 
the toolbar, eliminating the series of steps necessary when using the pull down menus. 

Annotation The Annotation toolbar contains shortcuts to the annotation features, such as select, 
save, delete, and create. 

Image The Image toolbar provides shortcuts for manipulating images. Some of the buttons 
available are pan mode, process a page using OCR, show index value, rotating, and 
zooming. 

Script The Script toolbar provides shortcuts for up to 20 script-based functions. To activate the 
buttons on this toolbar, your system administrator must create a file named AEX32.TXT 
containing a script that assigns AppXtender functions to the Script toolbar buttons. The 
AppXtender Software Developer Kit (AppXtender SDK) provides documentation on 
AppXtender scripting. (The Script toolbar is not available in AppXtender Image Capture.) 

Batch Index The Batch Index toolbar provides shortcuts to the batch indexing feature. From the Batch 
Index toolbar, you can create new documents and pages from a batch, delete a page 
from a batch, and navigate from page to page in a batch or document. (The Batch Index 
toolbar is not available in AppXtender Image Capture.) 

Scan The Scan toolbar contains shortcuts for scanning options and configuration settings such 
as manual feed, auto feed, single feed, rescan, and different automatic-rotation options. 
ApplicationXtender Desktop Installation Guide
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menus, even if the toolbar is hidden. Toolbars can be removed to 
create more space for displaying documents. 

To display or hide a toolbar: 

1. From the View menu, select Toolbars. In the Toolbars submenu, 
the name of each displayed toolbar has a check mark next to it. 

2. In the Toolbars submenu, click the name of the toolbar you want 
to display or hide. If the toolbar you selected was previously 
displayed, it is now hidden. If the toolbar you selected was 
previously hidden, it is now displayed.

Changing the Size 
of Toolbar Buttons

The default size of AppXtender Document Manager toolbar buttons 
may be too small for some users. You can change the size of 
AppXtender Document Manager toolbar buttons, if necessary.

To make small toolbar buttons larger: 

1. From the View menu, select Toolbars. In the Toolbars submenu, a 
check mark indicates the current button size setting. 

2. If Small Icons are enabled, in the Toolbars submenu, click Large 
Icons. The buttons increase in size.

To make large toolbar buttons smaller: 

1. From the View menu, select Toolbars. In the Toolbars submenu, a 
check mark indicates the current button size setting. 

2. If Large Icons are enabled, in the Toolbars submenu, click Small 
Icons. The buttons decrease in size.

Customizing 
Toolbars

Any AppXtender Document Manager toolbar can be customized to 
meet your needs. Buttons can be deleted from the toolbar, added to 
the toolbar, or re-ordered.
Configuring Toolbars, Title Bar, and Status Bar 2-5
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To customize a toolbar:

1. Right-click the toolbar to be customized. From the shortcut menu 
that appears, select Customize. The Customize Toolbar dialog box 
appears. 

Figure 2-1 Customize Toolbar Dialog Box

2. You have several choices: 

• Remove buttons from the toolbar by double-clicking the 
button name in the Current toolbar buttons list or by selecting 
the button name and clicking Remove. 

• Add buttons to the toolbar by double-clicking the button 
name in the Available buttons list or by selecting the button 
name and clicking Add. 

• Re-order buttons by selecting a button name in the Current 
toolbar buttons list and clicking Move Up or Move Down or 
by dragging the button name to the new location.

• Reset to a pre-defined list of toolbar buttons by clicking Reset. 

3. After you have completed customizing the toolbar, click Close. 

Configuring the Title 
Bar

When documents are displayed in the Document Display view, 
information about each document appears in the Document Display 
view title bar, including a value for each document from one of its 
index fields. If a document window is maximized in the Document 
Display view, this information appears in the title bar for the main 
AppXtender Document Manager window.

Similarly, when a batch is displayed in the Batch Display view, 
information about that batch appears in the Batch Display view title 
bar, including the name specified for the batch when it was created. 
ApplicationXtender Desktop Installation Guide
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For each application, you can specify which index field is used to 
populate the title bar. You can also configure the title bar to display 
the name of the AppXtender data source that contains the document, 
the name of the application that contains the document, or both for 
each application. 

To configure the Document Display view title bar: 

1. In the Applications view, right-click the application for which you 
want to configure the Document Display view title bar. From the 
shortcut menu that appears, select Properties. The Properties 
dialog box for that application appears.

2. Select the Title tab.

Figure 2-2 Properties Dialog Box: Title Tab

3. Specify whether you want the name of the AppXtender data 
source to appear in the Document Display view title bar. You 
have the following choices: 

• To include the name of the AppXtender data source, enable 
the Data Source Name check box.

• To leave out the name of the AppXtender data source, clear the 
Data Source Name check box.

4. Specify whether you want the name of the application to appear 
in the Document Display view title bar. You have the following 
choices: 

• To include the name of the application, enable the Application 
Name check box.
Configuring Toolbars, Title Bar, and Status Bar 2-7
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• To leave out the name of the application, clear the Application 
Name check box.

5. In the Field Value of drop-down list, select the name of the index 
field that you want to include in the Document Display view title 
bar.

6. Save your changes. You have the following choices: 

• To save changes and keep the Properties dialog box open, click 
Apply.

• To save changes and close the Properties dialog box, click OK.

The next time you display a document, the Document Display view 
title bar reflects your changes.

Displaying or Hiding 
the Status Bar

The status bar appears at the bottom of the AppXtender Document 
Manager window and contains each of the following from left to 
right: 

◆ Help messages for AppXtender Document Manager functions, 
describing toolbar button functions and menu item functions

◆ The name of the active application

◆ The page number of the currently displayed page

◆ The total number of pages in the currently displayed document

◆ The version number of the currently displayed version

◆ The total number of versions in the currently displayed page

The AppXtender Document Manager status bar can be removed from 
the window to save space for the Document Display view. 

To display or hide the status bar: 

1. Click the View menu. In the View menu, the Status Bar command 
has a check mark next to it if the status bar is currently displayed.

2. From the View menu, select Status Bar. If the status bar was 
previously displayed, it is now hidden. If the status bar was 
previously hidden, it is now displayed. 
ApplicationXtender Desktop Installation Guide
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Customizing AppXtender Document Manager Views
The Applications, Query, Workflow, and Thumbnail views can be 
modified to set up the AppXtender Document Manager window 
according to the user’s needs. By changing the way AppXtender 
Document Manager views display, you can customize the 
AppXtender Document Manager window. 

The Applications, Query, Workflow, and Thumbnail views can each 
be configured to appear as a docked view, as a dialog box, or as a 
subwindow. The Applications view and the Query view can also be 
configured to "hide on use." 

The AppXtender Workflow Workbox view is available only if the 
AppXtender Workflow client is installed on the AppXtender Document 
Manager workstation. The Query view, Thumbnail view, and AppXtender 
Workflow Workbox are not available in AppXtender Image Capture. 

For more information, see the following topics: 

◆ Docking a View on page 2-9

◆ Displaying a View as a Dialog Box on page 2-11

◆ Displaying a View as Subwindow on page 2-12

◆ Hiding a View on Use on page 2-13

◆ Activating AppXtender Document Manager Full Screen Mode on 
page 2-14

◆ Managing the Query View Result Set on page 2-14

Docking a View An AppXtender Document Manager docked view has a grab bar. A 
grab bar is similar to a title bar except that it does not contain a title. 

Figure 2-3 AppXtender Document Manager Docked View Grab Bar

You can drag the view to the left, right, top, or bottom of the 
AppXtender Document Manager window by dragging this bar. A 
docked view automatically aligns with the AppXtender Document 
Manager window borders and cannot be moved beyond the borders. 
Customizing AppXtender Document Manager Views 2-9
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By default, the Applications, Query, Workflow, and Thumbnail views 
appear as docked views.

The AppXtender Workflow Workbox view is available only if the 
AppXtender Workflow client is installed on the AppXtender Document 
Manager workstation. The Query view, Thumbnail view, and AppXtender 
Workflow Workbox are not available in AppXtender Image Capture. 

The following procedure applies to only the Applications, Query, Workflow, 
and Thumbnail views. It does not apply to the Document Display view or the 
Index view.

To dock a view that is now a dialog box: 

1. Right-click inside the dialog box. From the shortcut menu that 
appears, select Allow Docking. Allow Docking can be toggled on 
or off. 

2. Click the grab bar, and drag the view to the desired position on 
the AppXtender Document Manager window. For the view to 
dock, you must drag it to the left, right, top or bottom edge of the 
AppXtender Document Manager window. When you release the 
mouse button, the view moves to that location. 

Figure 2-4 AppXtender Document Manager Window with Docked Views
ApplicationXtender Desktop Installation Guide
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Displaying a View 
as a Dialog Box

An AppXtender Document Manager dialog box has a title bar with a 
Close button. You can drag the view to a different location on your 
window by dragging the title bar. A dialog box is independent of the 
AppXtender Document Manager window borders. That is, it can be 
moved away from the AppXtender Document Manager window 
borders, in any direction. This behavior is often described as 
"floating."

Figure 2-5 AppXtender Document Manager Dialog Box Title Bar

The AppXtender Workflow Workbox view is available only if the 
AppXtender Workflow client is installed on the AppXtender Document 
Manager workstation. The Query view, Thumbnail view, and AppXtender 
Workflow Workbox are not available in AppXtender Image Capture. 

The following procedure applies to only the Applications, Query, Workflow, 
and Thumbnail views. It does not apply to the Document Display view or the 
Index view.

To display a view as a dialog box: 

1. Double-click the grab bar. The docked view becomes a dialog box.

2. Click the Title bar and drag the dialog box to the desired location 
on the AppXtender Document Manager window. 
Customizing AppXtender Document Manager Views 2-11
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Figure 2-6 AppXtender Document Manager Window with Query View as Dialog 
Box

Displaying a View 
as Subwindow

An AppXtender Document Manager subwindow has a title bar with 
Minimize, Maximize, and Close buttons. You can drag the view to a 
different location in the AppXtender Document Manager window by 
dragging the title bar. A subwindow is independent of the 
AppXtender Document Manager window borders but cannot be 
moved beyond them. This behavior is often described as "floating as 
an MDI window." 

Figure 2-7 AppXtender Document Manager Subwindow Title Bar

The AppXtender Workflow Workbox view is available only if the 
AppXtender Workflow client is installed on the AppXtender Document 
Manager workstation. The Query view, Thumbnail view, and AppXtender 
Workflow Workbox are not available in AppXtender Image Capture. 
ApplicationXtender Desktop Installation Guide
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The following procedure applies to only the Applications, Query, Workflow, 
and Thumbnail views. It does not apply to the Document Display view or the 
Index view.

To display a view as a subwindow: 

1. Right-click in the docked view or view dialog box. From the 
shortcut menu that appears, select Float as MDI Window. 

2. Click the Title bar and drag the subwindow to the desired 
location on the AppXtender Document Manager window. 

Figure 2-8 AppXtender Document Manager Window with Query View as 
Subwindow

Hiding a View on 
Use

By default, the views remain in the AppXtender Document Manager 
window until you close, or hide, them. That is, when you display the 
Query View, the Applications View remains. Also, when you display 
a document, the Query View remains. You can configure the 
Applications view to hide when you display the Query View, and 
you can configure the Query View to hide when you display a 
document. 
Customizing AppXtender Document Manager Views 2-13
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Similarly, by default, the views remain in the AppXtender Image 
Capture window until you close or hide them, which means, when 
you display the Batch List, the Applications View remains. You can 
configure the AppXtender Image Capture Applications view to hide 
when you display the Batch List. 

This is described as "hiding on use" because you use the Applications 
view to display the Query View and you use the Query View to 
display a document. When a view is configured to hide on use, this 
configuration is often described as "hide on use mode." In this mode, 
AppXtender Document Manager or Image Capture automatically 
hides the view after items have been selected. 

You can always display the hidden view using the Applications View 
button or the Query View button on the Main toolbar. The hide on 
use mode can be used on a view whether it displays as a docked 
view, as a dialog box, or as a subwindow.

The following procedures apply to only the Applications view and the Query 
view. They do not apply to the Document Display, Index, Workflow, or 
Thumbnail view.

To configure a docked view to hide on use: 

◆ Right-click the view’s grab bar. From the shortcut menu that 
appears, select Hide on Use. 

To configure a dialog box or subwindow to hide on use: 

◆ Right-click inside the dialog box or subwindow. From the 
shortcut menu that appears, select Hide on Use.

Activating 
AppXtender 
Document Manager 
Full Screen Mode

The Full Screen feature allows you to expand AppXtender Document 
Manager to fill the entire monitor screen. This feature allows you to 
maximize AppXtender Document Manager viewing.

This feature is not available in AppXtender Image Capture. 

To enable/disable full screen: 

◆ From the View menu, select Full Screen. 

Managing the 
Query View Result 
Set

After you search for a document, the Query view Result Set tab 
displays the document index records that met the search criteria you 
entered. There is a column for each field in the result set. You can 
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control the display of columns from the Result Set. For example, you 
can show or hide, reorder, or save columns from the Result Set. For 
more information, see the following topics: 

◆ Changing the Way the Result Set Lists Documents on page 2-15

◆ Hiding or Showing Result Set Columns on page 2-16

◆ Sorting the Result Set on page 2-17

◆ Reordering the Result Set Columns on page 2-17

◆ Resizing the Result Set Columns on page 2-18

◆ Saving the Result Set Columns on page 2-18

◆ Resetting Result Set Column Configuration on page 2-18

◆ Collapsing the Result Set on page 2-18

The Query view is not available in AppXtender Image Capture. 

Changing the Way the
Result Set Lists

Documents

You can change the way the Result Set lists your documents. 

To change the way the Result Set lists your documents: 

1. Right-click the Result Set. From the shortcut menu that appears, 
select View As. Another shortcut menu appears.

2. You have the following choices: 

• To display only the first index field of each record and a small 
folder icon next to each record, select Names. 

Figure 2-9 Displaying Names in the Result Set

• To display all index fields and a small folder icon next to each 
record, select Details. 
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Figure 2-10 Displaying Details in the Result Set

• To display only the first index field of each record and a large 
folder icon above each record, select Folders. 

Figure 2-11 Displaying Folders in the Result Set

Hiding or Showing
Result Set Columns

The first time you log into an AppXtender application, the Result Set 
tab displays a column for each of the index fields in the application, 
plus a column for the number of pages in each document. You can 
hide any of these columns. There is also a column for the document 
ID, which is hidden by default. You can configure this column to 
appear in the Result Set. 
ApplicationXtender Desktop Installation Guide



2
Configuring AppXtender Document Manager Workstations

AXIG.book  Page 17  Monday, December 5, 2005  12:43 PM
To hide or show a column: 

1. Right-click a column heading in the Result Set. From the shortcut 
menu that appears, select Settings. The List Column Editor dialog 
box appears. 

Figure 2-12 List Column Editor Dialog Box

2. Click the check box next to the name of the column that you want 
to hide or show.

3. When each column that you want to hide has no check mark and 
each column that you want to show has a check mark, click OK. 

Sorting the Result Set Ascending or descending sorts can be performed on any index 
column listed in the Result Set tab. To sort a field in ascending order, 
click the column heading of the desired field. To sort a field in 
descending order, click the column heading of the field again. 

In addition, your workstation may be configured to sort the result set 
automatically based on the last column selected or based on the 
document ID. The Display tab of the Configuration dialog box allows 
this configuration. For information, see Use KeyView to Display Foreign 
Files on page 2-26.

Reordering the Result
Set Columns

The first time you log into an AppXtender application, the Result Set 
tab displays columns in a default order. You can change the order of 
these columns. 

To move a column: 

◆ Drag the column to the position you want to use. 
Customizing AppXtender Document Manager Views 2-17
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Resizing the Result Set
Columns

The first time you log into an AppXtender application, the Result Set 
tab displays default column widths for each index field. These 
column widths are resizable. Because the data is truncated in narrow 
columns, resizing is a useful display tool. 

To resize a column width: 

1. Drag the boundary between column headings to the position you 
want. 

2. Right-click the column headings. From the shortcut menu that 
appears, select Save Columns. The column configuration is saved 
for the current user name and application. 

Saving the Result Set
Columns

You can save Result Set column configuration changes for the current 
user name and application.

To save column settings: 

◆ Right-click any column heading in the Result Set. From the 
shortcut menu that appears, select Save Columns. The column 
configuration is saved for the current user name and application.

Resetting Result Set
Column Configuration

If you have made changes to the way columns appear in the Result 
Set (such as hiding columns, showing the Document ID column, 
changing the column order, or changing the column width) you can 
set them back to their default configuration.

To reset Result Set columns: 

1. If you have your View As option set to Folders or Names, you 
must first change that option to Detail. For instructions, see 
Changing the Way the Result Set Lists Documents on page 2-15.

2. Right-click any of the Result Set column headings. From the 
shortcut menu that appears, select Settings. The List Column 
Editor dialog box appears. 

3. Click Reset All.

Collapsing the Result
Set

You can collapse the Result Set to display only those documents that 
you select.

To collapse the Result Set: 

1. In the Result Set tab, select the documents you want to view in the 
Result Set. You have the following choices: 

• If you want to select only one document, click the document.
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• If you want to select multiple documents in consecutive order, 
hold down [SHIFT] and click the first and last document.

• If you want to select multiple documents that are not in 
consecutive order, hold down [CTRL] and select each 
document individually.

2. Right-click within the Result Set. From the shortcut menu that 
appears, select Collapse. Only the documents you selected are 
listed in the Result Set tab.
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Data Sources
One aspect of configuring the AppXtender Document Manager 
window is the selection of data sources. You can use the AppXtender 
Data Source Selector to specify the default data source for 
AppXtender AppGen and the three import wizards. You can also use 
the AppXtender Data Source Selector to select multiple data sources 
for display in AppXtender Document Manager. For instructions, 
refer to the ApplicationXtender Document Manager User’s Guide.

When you set an application as the "active" application within 
AppXtender Document Manager, the data source that contains that 
application also becomes active. Setting a data source as active within 
AppXtender Document Manager is not the same as setting a data 
source as default in the AppXtender Data Source Selector or Queue 
Manager. For instructions on setting an application (and its data 
source) as active, refer to the ApplicationXtender Document Manager 
User’s Guide.

When you save AppXtender Document Manager workstation 
settings, each of these settings is saved: 

◆ Default data source

◆ Selected data sources

◆ Active data source

For instructions on saving AppXtender Document Manager 
workstation settings, see Saving Settings on page 2-91.
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Opening the Configuration Dialog Box
As the AppXtender system administrator, you control the level of 
access that the users on your AppXtender system have to 
functionality on their AppXtender Document Manager workstations. 
You can allow users to configure all aspects of AppXtender 
Document Manager functionality on their individual workstations, 
or you can restrict configuration rights and only allow configuration 
of options relating to the display of information in AppXtender 
Document Manager. 

If the Configure WS privilege is enabled in a user’s security profile, 
the user has access to all AppXtender Document Manager 
configuration options. If it is disabled, you can set configuration 
options and the user cannot access the configuration tabs to change 
those options. 

The ApplicationXtender Document Manager User’s Guide and the 
ApplicationXtender Image Capture User’s Guide include information on 
the configuration options that are available to users regardless of 
their security settings. This chapter contains information relating to 
the more advanced configuration options. 

◆ Each AppXtender Document Manager workstation has a 
Configuration dialog box, accessible through AppXtender 
Document Manager, which can be used to customize the behavior 
of AppXtender Document Manager on the workstation. 

◆ Each AppXtender Image Capture workstation also has a 
Configuration dialog box, accessible through AppXtender Image 
Capture, which can be used to customize the behavior of 
AppXtender Image Capture on the workstation. 

Many configuration options are available to accommodate individual 
operational needs. Some of the options on the AppXtender Document 
Manager Configuration dialog box are not available on the 
AppXtender Image Capture Configuration dialog box, because they 
configure features that are not necessary in AppXtender Image 
Capture.

Some configuration options are cosmetic and do not alter the way the 
system performs, such as options controlling the look and feel of the 
main screen. Others are integral to the functionality of AppXtender 
Document Manager, such as a default digital certificate; the file types 
and formats that AppXtender Document Manager use; and interface 
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options for e-mail, fax server, and optical character recognition (OCR) 
packages.

This topic explains the configuration options available in 
AppXtender Document Manager, including: export formats, font 
types for text, COLD/ERM display settings, display zoom default, 
OCR settings, full-text settings, and various other AppXtender 
system settings. 

System defaults are in place for most features, such as zoom and tile. 
These defaults can be changed in the Configuration dialog box. 
Changes that you make to the options in the Configuration dialog 
box are saved when you save workstation settings. For a detailed 
description of what options are saved, see Saving and Loading Settings 
on page 2-91.

To open the Configuration dialog box: 

1. From the File menu, select Configuration. The Configuration 
dialog box appears.

2. Set the desired options according to the instructions in the 
following topics: 

• View Tab on page 2-24

• Display Tab on page 2-28

• Fonts Tab on page 2-31

• Scan Tab on page 2-35

• COLD Tab on page 2-38

• Print Tab on page 2-41

• E-Mail Tab on page 2-46

• Export Tab on page 2-53

• File Types Tab on page 2-58

• Data Tab on page 2-60

• Paths Tab on page 2-70

• Full Text Tab on page 2-73

• OCR Tab on page 2-76

• Fax-in Tab on page 2-82

• Thumbnail Tab on page 2-84 

• Document Signing Tab on page 2-86

• Workflow Tab on page 2-90
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3. Click OK. The Configuration dialog box closes and any changes 
you have made are saved.
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View Tab
The View tab of the Configuration dialog box allows you to configure 
several aspects of viewing documents and batches. Some of the 
options on the AppXtender Document Manager Configuration dialog 
box View tab are not available on the AppXtender Image Capture 
Configuration dialog box View tab, because they configure features 
that are not necessary in AppXtender Image Capture. 

Figure 2-13 Configuration Dialog Box: View Tab

Image Size Options Image Size options control the default display size of images 
displayed in AppXtender Document Manager or Image Capture. You 
can use these options with all supported image types. (In 
AppXtender Document Manager, these options also apply to text 
when the Allow zoom option is enabled on the COLD tab of the 
Configuration dialog box.) 

To change the default image size setting: 

1. In the Configuration dialog box, select the View tab. 

2. Under Image Size, select one of the five zoom settings. 
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These settings are explained in the following table: 

3. If you have enabled the Use zoom setting radio button, select the 
desired ratio. You can click the User zoom setting drop-down list 
and select the desired ratio (standard options range from 25% to 
400%) or type the preferred percentage in the text box. 

4. Click OK to save the settings.

Zoom Settings are 
Pixels

By default, AppXtender Document Manager takes into consideration 
both the image resolution and monitor resolution when rendering 
images for display. By enabling the Zoom settings are pixels option, 
AppXtender Document Manager displays images in raw pixel size, 
disregarding image and monitor resolution. 

Scale-to-Gray When the Scale-to-gray option is enabled, AppXtender Document 
Manager displays bi-tonal (black and white) images as grayscale, 
which is frequently a more legible format. Various shades are used to 
convert black and white images for the highest readability. This 
option applies to bi-tonal images only.

Display Text View of 
Page

AppXtender Document Manager allows users to process images 
using OCR, creating an alternate "text view" of the image. Users can 

Table 2-2 Image Size Options

Option Description

Fit to 
window

If this option is chosen as the default, AppXtender Document Manager displays images to fit 
the display window either top to bottom or left to right, while maintaining the original aspect 
ratio of the image and displaying the entire image.

Fit to 
window 
height

If this option is chosen as the default, AppXtender Document Manager displays images to fit 
the window from top to bottom. You might need to scroll left or right to see the sides of the 
image.

Fit to 
window 
width

If this option is chosen as the default, AppXtender Document Manager displays images to fit 
the window from left to right. You might need to scroll up or down to see the top or bottom of 
the image.

Actual size If this option is chosen as the default, AppXtender Document Manager displays images as 
actual size (one pixel stored is equal to one pixel on the monitor). 

Use zoom 
setting

If this option is chosen as the default, AppXtender Document Manager displays images using 
the default zoom percent. The Use Zoom Setting drop-down list allows you to set the default 
ratio.
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switch between the original image and the text view of the image at 
will. The Display text view of page option sets the default document 
display to text format or image format. When the check box is 
enabled on the View tab of the Configuration dialog box, AppXtender 
Document Manager displays documents as text when applicable. If 
no OCR view is available, the page will be automatically processed 
using OCR to create an OCR view when it is viewed. When the check 
box is disabled, AppXtender Document Manager always displays 
documents in image format. (This option is not available in 
AppXtender Image Capture.)

Restore Last Layout 
at Startup

If the Restore last layout at startup option is enabled on the View tab 
of the Configuration dialog box, the AppXtender Document Manager 
window layout is automatically saved when you exit AppXtender 
Document Manager. This includes the following settings: 

◆ AppXtender Document Manager window size and location

◆ Toolbar locations and toolbar button size

◆ View type (docked view, dialog box, or subwindow) for the 
Applications, Query, Workflow, and Thumbnail views

◆ Location and size of the Applications, Query, Workflow, and 
Thumbnail views

If this option is disabled, the window layout is not saved on exit. 
When you open AppXtender Document Manager, the window 
layout reverts to the previously saved settings.

Use KeyView to 
Display Foreign Files

When this option is enabled, AppXtender Document Manager uses 
the Verity KeyView Viewer technology to display the contents of 
various foreign files. The appearance of a foreign file in KeyView is 
similar to its appearance in its native viewer, but not exactly the same. 
For a list of Verity KeyView Viewer-supported file types, refer to the 
"Creating Documents" chapter of the ApplicationXtender Document 
Manager User’s Guide. When this option is disabled, AppXtender 
Document Manager displays a foreign file page as an icon.

Use Acrobat Reader 
to Display PDF Files

When this option is enabled, AppXtender Document Manager uses 
the Acrobat Reader technology to display the contents of PDF files. 
When this option is disabled, AppXtender Document Manager uses 
PDF Library to display each PDF page. If you enable the option for 
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AppXtender Document Manager or Image Capture, it is enabled for 
both.

If you choose to display a PDF document in Acrobat Reader, you cannot 
annotate the pages and full-text search hits on the PDF pages will not be 
highlighted. However, the PDF Library performs document printing of a PDF 
page regardless of the view setting.

Allow Map of 
Unknown Data 
Sources to Existing 
Data Sources

When this option is enabled, AppXtender Document Manager will 
allow you to specify a data source for a document for which the data 
source is unknown. The original data source may be unknown if you 
are opening a document that has been somehow saved to your 
computer or if a reference to an AppXtender document has been 
e-mailed to you. If the name of the data source listed in the reference 
is named different from the data sources that are configured on your 
computer and you attempt to open the file, the Pick a Data Source 
dialog box will appear, allowing you to specify the correct data 
source to use. For more information about selecting a data source 
from the Pick a Data Source dialog box, refer to the ApplicationXtender 
Document Manager User’s Guide. (This option is not available in 
AppXtender Image Capture.) 
View Tab 2-27



2

2-28

Configuring AppXtender Document Manager Workstations

AXIG.book  Page 28  Monday, December 5, 2005  12:43 PM
Display Tab
The Display tab of the Configuration dialog box contains options for 
various AppXtender Document Manager display features. Some of 
the options on the AppXtender Document Manager Configuration 
dialog box Display tab are not available on the AppXtender Image 
Capture Configuration dialog box Display tab because they configure 
features that are not available in AppXtender Image Capture. 

Figure 2-14 Configuration Dialog Box: Display Tab

Screen DPI The Screen DPI settings refer to the dots per inch of the system 
monitor. AppXtender Document Manager takes this information 
from the video interface card installed with the system. You can 
overwrite the defaults by entering new Horizontal or Vertical 
settings. If you want to change the Horizontal or Vertical settings 
back to the defaults from the video interface card, click Reset.

PgUp/PgDn in 
Dual-Page View

This option dictates how the [PAGE UP] and [PAGE DOWN] keys 
operate in AppXtender Document Manager when a document or 
batch is in dual-page display mode. This mode is also known as Split 
View. The Split View feature splits the Document Display view or the 
Batch Display view so that multiple pages of the same document or 
batch are displayed. 
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In Split View, the actions performed by your [PAGE UP] and [PAGE 
DOWN] keys depend on the PgUp/PgDn in Dual-Page View setting 
in the Display tab: 

◆ When you select Next/previous 2 pages, the keys page through 
two pages at a time. For example, if you display a document or 
batch with four pages in Split View, pages 1 and 2 appear first, 
then pages 3 and 4.

◆ When you select Next/previous page, the keys page through one 
page at a time. For example, if you display a document or batch 
with four pages in Split View, pages 1 and 2 appear first, then 
pages 2 and 3.

Query Results The Query Results options allow you to configure the maximum 
number of documents that will be included in a result and how the 
result set will be sorted. (These options are not available in 
AppXtender Image Capture.) 

Maximum Query
Results

Using the Maximum Query Results option, you can set the maximum 
number of documents that will be included in a result set. The default 
is 2048 documents. The higher this value is set, the larger the result 
set can be. If a query returns more documents than the maximum 
number, the result set will be truncated. 

Sort Result Set
Automatically

This option sets the default to automatically sort index records 
displayed in the query result set based on the column field selected. 
When this option is enabled on the Display tab of the Configuration 
dialog box, the new query displayed in the result set is sorted by the 
last column field selected. When this option is disabled, AppXtender 
Document Manager displays the index records in the query result set 
based on one of the two Sort Order of Document ID options specified 
in the Sort Order of Document ID topic. For more information, see 
Sort Order of Document ID on page 2-30.

Automatic sort overrides sort order of document ID.

Maximum Index
Retrieved

If the application in which you are searching has the Multiple indexes 
referencing single document setting enabled, the result set may 
contain more than one record for each document. For example, if the 
Maximum Query Results value on the Display tab in the 
Configuration dialog box is set to 2048 documents, your result set 
may contain more than 2048 index records. To improve performance, 
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you can use the Maximum Index Retrieved setting to limit the 
number of index records that are listed in the result set. 

The default setting is 1000 index records. The higher the value, the 
larger the result set can be. If a query returns more index records than 
the maximum number, the result set is truncated.

Sort Order of
Document ID

This feature lets you control the display of items in the query result 
set. When Ascending order is enabled, AppXtender Document 
Manager displays index records listed in the query result set by 
ascending chronological order. Enabling the Descending order sorts 
the documents in reverse chronological order. 

Ascending Order
This option sets the sort order of the query result set in ascending 
chronological order, based on the document ID number. If this option 
is chosen as the default, AppXtender Document Manager displays 
index records sequentially, from low to high, in the query view.

Descending Order
This option sets the sort order of the query result set to descending 
chronological order, based on the document ID number. If this option 
is chosen as the default, AppXtender Document Manager displays 
index records sequentially, from high to low, in the query view.
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Fonts Tab
Using the Fonts tab of the Configuration dialog box, you can choose 
the fonts for displaying and printing text documents. 

Figure 2-15 Configuration Dialog Box: Fonts Tab

For more information, see:

◆ Opening the Configuration Dialog Box on page 2-21

◆ Screen Fonts on page 2-31

◆ Printer Fonts on page 2-32

◆ Simulate Box Drawing Characters on page 2-34

Screen Fonts The font used for text display depends on whether the page has a text 
overlay, an image overlay, or no overlay at all. It also depends on 
whether the user is allowed to zoom in on the page.

Zoom is configured using the Allow zoom setting on the COLD tab. For more 
information on configuring Allow zoom, see Allow Zoom on page 2-39.

Using the Screen Fonts setting, you can configure the fonts used for 
text display. 
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To set the screen fonts:

1. Select the font to configure from the Screen Fonts list. You have 
the following choices:

• Page (fixed size)

• Page (variable size)

• Image Form Overlay

The font that you select depends on whether the text page has a 
text or image overlay and whether zoom is enabled. The 
following table describes which font is used for text display in 
each scenario:

2. Click Change. The Font dialog box appears.

AppXtender supports only fixed pitch fonts. The fonts that are displayed 
are the only fixed pitch fonts currently on your computer.

3. Choose the font, style, and size you want to use for text display.

If you are configuring the Image Form Overlay font, you do not need to 
select a font size. Text on pages with an image overlay automatically 
appears at a calculated size that is not configurable.

4. Click OK to save the settings.

Printer Fonts The font used for printing text documents depends on whether the 
page has a text overlay, an image overlay, or no overlay at all. It also 
depends on whether the user is allowed to zoom in on the page.

Zoom is configured using the Allow zoom setting on the COLD tab. For more 
information on configuring Allow zoom, see Allow Zoom on page 2-39.

Table 2-3 Configuring Screen Fonts with Form Overlay

Page Type When Zoom is Enabled When Zoom is Disabled

Text with no overlay Page (variable size) Page (fixed size)

Text with a text overlay Page (variable size) Page (fixed size)

Text with an image overlay Image Form Overlay Image Form Overlay
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Using the Printer Fonts setting, you can configure the fonts used for 
printing text. 

You can configure the print fonts to be the same as the display fonts. 
For more information on configuring screen fonts, see Screen Fonts on 
page 2-31.

However, you may need to configure the print fonts differently from 
the display fonts if the fonts installed on the workstation are different 
from those installed on the printer.

To set the print fonts:

1. Select the font to configure from the Printer Fonts list. You have 
the following choices:

• Page (fixed size)

• Page (variable size)

• Image Form Overlay

The font that you select depends on whether the text page has a 
text or image overlay and whether zoom is enabled. The 
following table describes which font is used for printing text in 
each scenario:

2. Click Change. The Font dialog box appears.

AppXtender supports only fixed pitch fonts. The fonts that appear in the 
list are the only fixed pitch fonts currently on your printer.

3. Choose the font, style, and size you want to use for text display.

If you are configuring the Image Form Overlay font, you do not need to 
select a font size. Text on pages with an image overlay automatically 
prints at a calculated size that is not configurable.

4. Click OK to save the settings. 

Table 2-4 Configuring Printer Fonts with Form Overlay

Page Type When Zoom is Enabled When Zoom is Disabled

Text with no overlay Page (variable size) Page (fixed size)

Text with a text overlay Page (variable size) Page (fixed size)

Text with an image overlay Image Form Overlay Image Form Overlay
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Simulate Box 
Drawing Characters

AppXtender uses "box drawing characters" to support the use of 
fonts that require box drawing characters to correctly represent 
AppXtender text documents. Because of this, several characters in the 
AppXtender font set are replaced with box drawing characters. For 
documents that are written in foreign languages, this substitution 
may interfere with the font set requirements for the foreign language. 
Characters display as boxes rather than as the characters that they 
should be. 

For example, when viewing documents written in the Danish 
language, the box drawing character substitution interferes with the 
font set requirements for Danish. 

You need to disable the Simulate Box Drawing Characters options to 
view documents and text form overlays written in any foreign 
language that uses characters that are assigned using the ASCII 
values from 176 to 223.

To allow viewing of documents written in foreign languages using 
the ASCII values from 176 to 223: 

1. Disable the Enable Support for Form Text option to allow display 
of form overlays written in foreign languages using the ASCII 
values from 176 to 223.

2. Disable the Enable Support for Data Text option to allow display 
of text documents written in foreign languages using the ASCII 
values from 176 to 223. 
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Scan Tab
The Scan tab of the Configuration dialog box allows you to customize 
your batch scanning process. 

Figure 2-16 Configuration Dialog Box: Scan Tab

Removing Blank 
Pages

You can configure AppXtender Document Manager to automatically 
remove blank pages from the batch while you are scanning. 
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To configure the automatic removal of blank pages: 

1. On the Scan tab of the Configuration dialog box, select the 
Remove blank pages check box to enable the option. The 
Threshold slider becomes available. 

Figure 2-17 Configuration Dialog Box: Scan Tab: Removing Blank Pages

2. Use the Threshold slider to adjust the setting for what the scanner 
recognizes as a blank page. Keep in mind the following points: 

• If you want to allow a noisier image to be recognized as a 
blank page (and therefore removed), adjust the slider towards 
Noisier. 

• If you want to allow a cleaner image to be recognized as a 
blank page (and therefore removed), adjust the slider towards 
Cleaner.

3. Click OK to save the settings.

CAUTION!
As you begin to use this feature, examine the pages that are 
scanned and take note of which pages are automatically removed 
from the document or batch as you scan them. If you find that 
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pages are being removed that should not be removed, adjust the 
slider towards Cleaner. You must make sure that the Threshold 
slider setting is appropriate for the pages that you are scanning.

Synchronized Scan With some types of scanning, the images are scanned faster than 
AppXtender Document Manager can display them. The 
Synchronized scan option slows down your scanner so that 
AppXtender Document Manager can display each scanned image. 
You have the following choices: 

◆ If you want to review each page as it is scanned, enable the 
Synchronized scan option.

◆ If you want to allow your scanner to scan images at its highest 
speed, disable the Synchronized scan option.

Scanner Manual 
Feed Timeout

This option sets the scanner timeout for scanning that is performed 
while in the manual feed mode. The default is 20 seconds. The 
timeout option specifies how much time you will need to put more 
pages in the scanner without having to manually continue the scan 
process. This option can be set higher or lower to meet your needs. 
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COLD Tab
The COLD tab of the AppXtender Document Manager Configuration 
dialog box allows you to configure the display of the following file 
types: 

◆ ApplicationXtender Reports Management (AppXtender Reports 
Mgmt) documents

◆ Text, as defined on the File Types tab of the Configuration dialog 
box (For instructions, see File Types Tab on page 2-58.)

The COLD tab is not available on the AppXtender Image Capture 
Configuration dialog box. 

Figure 2-18 Configuration Dialog Box: COLD Tab

Cache Forms When this option is selected, forms will be cached locally in memory 
to facilitate quicker retrieval. This setting holds for the current session 
only. Once you exit AppXtender Document Manager, the form is no 
longer held in cache. Click to place a check mark in the Cache Forms 
check box to enable the option. 

Allow Paste Text Users are not required to use the Paste Special command to insert text 
pages from the clipboard. AppXtender supports standard pasting of 
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text pages from the clipboard with the Paste command. The Allow 
paste text option must be enabled to activate this function. 

Allow Zoom When this option has a check mark in it, the Zoom feature becomes 
active for AppXtender Reports Mgmt and COLD and ASCII 
documents. Consequently, you can zoom in and out on AppXtender 
Reports Mgmt or COLD and ASCII documents if a variable font is 
selected.

Display As Image 
Only

When enabled, this option restricts the user's ability to change an 
AppXtender Reports Mgmt document with an Image Form Overlay 
to either a COLD or ASCII Form Overlay or without the Image Form 
Overlay. 

Form Overlay 
Settings

The Form Overlay Settings configure display and print options for 
AppXtender Reports Mgmt documents. Separate settings apply to 
display and print. COLD and AppXtender Reports Mgmt documents 
can be configured to display or print with a form overlay.

Screen This option determines how AppXtender Reports Mgmt documents 
are displayed. Select Off to display documents without a form 
overlay. Select Text to display documents with a text form overlay, or 
select Image to display documents with an image form overlay.

Printer This option determines how AppXtender Reports Mgmt documents 
are printed. Select Off to print documents without a form overlay. 
Select Text to print documents with a text form overlay, or select 
Image to print documents with an image form overlay.

Default Color Bar 
Settings

This feature lets you view text documents with a "color" bar 
background. When a document is displayed with the color bar 
enabled, the background will be composed of alternating bars of a 
selected color and white. You can change the color and the width of 
the bands. 
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Figure 2-19 Configuration Dialog Box: COLD Tab: Color Bar Options

Show Use this option to turn the color view on or off. A check mark 
indicates that color view is on. No check mark indicates that color 
view is off.

Lines This option determines the width of the bands. The default setting is 
three lines.

To set the line width: 

◆ In the Lines box, type or select the number of lines desired by 
using the up or down arrow.

Color This option sets the color to be used in color view.

To set the line color: 

◆ In the Color drop-down list, click the color of your choice. (If the 
color that you want to use is not listed, select Custom. The 
standard Windows Color dialog box appears, allowing you to 
create a color for the color bar.)
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Print Tab
The Print tab of the AppXtender Document Manager Configuration 
dialog box allows you to configure how documents or pages are 
printed from AppXtender Document Manager. The Print tab of the 
AppXtender Image Capture Configuration dialog box allows you to 
configure how pages are printed from AppXtender Image Capture. 
Some of the options on the AppXtender Document Manager 
Configuration dialog box Print tab are not available on the 
AppXtender Image Capture Configuration dialog box Print tab, 
because they configure features that are not available in AppXtender 
Image Capture. 

Figure 2-20 Configuration Dialog Box: Print Tab

Print Original Size When an AppXtender page is printed, the printer automatically fits 
the contents of the page to a standard printable area. If some 
characters in the page are outside the printable area of the page, the 
printer slightly reduces the overall size of the page so that all 
characters can fit. However, there are occasions when a perfect 
one-to-one (original to printed) match is required. AppXtender 
Document Manager meets this requirement through the Print 
original size feature. This function allows AppXtender Document 
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Manager to override the printer’s fixed printable area. All characters 
in a page are scaled to print exact original size. 

When the Print Original Size option is enabled, AppXtender 
Document Manager overrides the printer’s printable area and prints 
the selected page in exact original size. When disabled, the printer 
shrinks or enlarges the selected page to fit the printable area. 

This option applies to the following page types: 

◆ Images

◆ Text, as defined on the File Types tab of the Configuration dialog 
box (For instructions, see File Types Tab on page 2-58.)

Dithering Dithering is a technique used in computer graphics to create the 
illusion of varying shades of gray on a monochrome display or 
printer. Dithering relies on treating areas of an image as groups of 
dots that are colored in different patterns. Dithering takes advantage 
of the eye's tendency to blur spots of different colors by averaging 
their effects and merging them into a single perceived shade or color. 
Depending on the ratio of black dots to white dots within a given 
area, the overall effect is of a particular shade of gray. Dithering is 
used to add realism to computer graphics and to soften jagged edges 
in curves and diagonal lines at low resolutions.

If you are printing a color image to a monochrome (black and white) 
printer, you can improve the quality of the printout by enabling the 
Dithering option. When this option is enabled and you send a color 
image to a monochrome printer, AppXtender Document Manager 
dithers the image. For example, if you print a color, 400 K, 200 DPI 
image to a monochrome printer, the result is a black and white, 3600 
K, 600 DPI image of the same size. Each pixel in the color image 
becomes nine pixels in the black and white image.

When the Dithering option is enabled and you send an image to a color 
printer, AppXtender does not dither the image. 

Print Toolbar Button The Print Toolbar Button options allow you to configure the Print 
button on the Main toolbar. You have the following choices: 

◆ If you want the Print button to print the entire displayed 
document, select Document print.
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◆ If you want the Print button to print only the displayed page, 
select Page print.

◆ If you want the Print button to display a Print dialog box for the 
currently displayed document, so that the user can specify the 
scope of each print job individually, select Prompt.

◆ If you want the Print button to display a Print dialog box for the 
currently displayed page, so that the user can specify the scope of 
each print job individually, select Prompt.

Acceleration The Acceleration options expedite the printing of documents or 
batches. Document Manager supports XipPrint accelerator cards, 
Talaris printers, and Quick PCL printing.

Pages with annotations, Cold and AppXtender Reports Mgmt pages with a 
form overlay, and pages with print endorsements (from AppXtender 
Document Manager) are not printed in accelerated mode. Whenever a page 
of one of these types is printed, AppXtender Document Manager ignores the 
acceleration setting while that page prints. 

XipPrint If you have a XipPrint II card, you can use the XipPrint printer 
acceleration feature. The XipPrint II is a card that can be installed in 
the SIMM socket of a printer. It takes over file decompression, 
allowing AppXtender Document Manager to process print jobs more 
quickly. 

Talaris If you have a Talaris 1794FT or 3290FT printer, you can use the Talaris 
printer acceleration feature. The Talaris 1794FT and 3290FT printers 
take over file decompression, allowing AppXtender Document 
Manager to process print jobs more quickly. 

Quick PCL If you have a PCL5 compatible printer, such as HP III, HP IV or 
Compaq, you can use the Quick PCL printer acceleration feature. 
This feature significantly improves printing performance for black 
and white images to any PCL5 compatible printers. Quick Print 
bypasses the Windows GDI layer so that AppXtender Document 
Manager communicates directly with the Windows printer driver. 
This substantially reduces cycle time. 

Quick Print is valid for bi-tonal images only. Grayscale and color images are 
processed at the standard rate. 
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Endorse Printed 
Pages

You can use this option to print pages with an identifying text 
message in one corner of each page. The message can include the 
page number of the page printed. Endorsements print on all pages as 
long as the option is enabled.

Endorsements are valid for all file types except HTML. 

To configure print endorsement: 

1. Click the Endorse Printed Pages check box. (To disable the 
endorsement, clear the check box.) 

Figure 2-21 Configuration Dialog Box: Print Tab: Endorsement Options

2. From the Position drop-down list, select an option. Available 
options include Lower right, Lower left, Upper right, and Upper 
left.

3. In the Text text box, type the message you want printed. To print 
the number of the current page in the endorsement, include %P in 
the endorsement text string. Endorsement text strings can be up 
to 10 lines, and each line can have up to 80 characters, including 
spaces. 

4. Enable or disable the Overlap on image option. (This option is not 
available when using XipPrint or Talaris acceleration.)
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• If this option is enabled, the endorsement overlaps any 
images. This option allows the image to be printed on a larger 
area of the page. 

• If this option is disabled, the images and the endorsement take 
up separate areas of the printed page. Also, if this option is 
disabled, the Print original size option becomes unavailable.

Consider disabling this option if the endorsement overlaps with 
an important part of the image, or if the endorsement is difficult 
to read with the image printed behind it.

The endorsement will be printed on every page in the location 
selected from the Position drop-down list. The page number will be 
printed wherever the %P is located within the text string. 
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E-Mail Tab
The E-Mail tab of the AppXtender Document Manager Configuration 
dialog box provides options for e-mailing AppXtender documents. 
AppXtender interfaces with Microsoft Outlook® or cc:Mail™ so that 
you can attach AppXtender documents or pages to electronic mail 
messages. (The E-Mail tab is not available on the AppXtender Image 
Capture Configuration dialog box.)

The attachment is displayed as an icon in the body of the e-mail 
message, and the recipient double-clicks the icon to view documents 
or pages. AppXtender Document Manager has both a Mail Document 
Reference feature and a Mail Document Page feature. Use this page to 
configure the Mail Document Pages feature in the Document menu 
and the Mail feature in the Page menu. 

Figure 2-22 Configuration Dialog Box: E-Mail Tab

Through e-mail configuration, any user can receive and view an 
e-mail message with an AppXtender attachment, even if AppXtender 
Document Manager is not installed on the user’s workstation. This is 
accomplished by converting the AppXtender document into a format 
that can be opened by an application that exists on the user’s 
workstation. If the recipient has only the Paint program, for example, 
AppXtender Document Manager can convert the attachment to a 
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bitmap format. The recipient can then view the attachment via Paint, 
because it reads bitmap files. 

For instructions on sending documents by e-mail, refer to the 
"Managing Documents" chapter of the ApplicationXtender Document 
Manager User’s Guide. 

E-Mail Formats On the E-Mail tab of the Configuration dialog box, all available 
formats for each image type (that is, Black & white images, 4/8-bit 
color images, and True color images), are listed. The following is an 
explanation of the E-Mail tab options that are available for your use.

Black & White Images
for E-Mail

This option determines the file format that AppXtender Document 
Manager will use for images. Select a file format from the Black & 
white images drop-down list. Your choices are Windows BMP, TIFF, 
and TIFF Compressed.

4/8-bit Color Images
for E-Mail

This option determines the file format that AppXtender Document 
Manager will use for 4/8-bit color images. Select an appropriate file 
format from the 4/8-bit color images drop-down list. Your choices are 
Windows BMP, Windows BMP Compressed, GIF, TIFF, and TIFF 
Compressed.

True Color Images for
E-Mail

This option determines the file format that AppXtender Document 
Manager will use when e-mailing true color images. Select an 
appropriate file format from the True color images drop-down list. 
Your choices are Windows BMP, GIF, JPEG, TIFF, and TIFF 
Compressed.

You can compress true color images using Joint Photographic Experts Group 
(JPEG) image compression. If you select JPEG, the JPEG quality factor (1-100) 
is enabled. For more information on compressing JPEG images, see JPEG 
Quality Factor (1-100) on page 2-47.

AppXtender does not support progressive JPEGs. Importing a progressive 
JPEG into AppXtender will result in the file being imported as a foreign file.

JPEG Quality Factor (1-100)
JPEG provides compression of true color images, such as 
photographs, artwork, and similar still images. There is always some 
loss of information when you use JPEG compression to compress an 
image. For example, when compressing a scanned photograph, the 
output image is not exactly identical to the input image.
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JPEG compression allows you to trade off between file size and 
output image quality. In most cases, you want to obtain a minimum 
file size by choosing the maximum amount of compression without 
affecting the output image quality. However, if image quality is not 
important, you can use a higher compression level to make an 
extremely small file. Conversely, if the image quality is important, 
you can use a lesser compression level to increase the quality until 
there is no visible change to the output image.

The JPEG quality factor (1-100) slider allows you to choose the 
compression setting for true color images. AppXtender uses the JPEG 
quality factor scale, which ranges from 1 to 100, where 1 indicates the 
smallest file size with the lowest quality and 100 indicates the largest 
file size with the best quality. 

Figure 2-23 Configuration Dialog Box: E-Mail Tab: JPEG Quality Factor

To set the level of JPEG compression for e-mailed images: 

1. On the E-Mail tab of the Configuration dialog box, select JPEG 
from the True color images drop-down list. The JPEG Quality 
Factor (1-100) slide ruler becomes available.

2. Use the slide ruler on the scale to adjust (reduce or increase) the 
level of compression and the quality factor that AppXtender 
applies to True color images when they are sent by e-mail. 

3. Click OK to save the settings.
ApplicationXtender Desktop Installation Guide



2
Configuring AppXtender Document Manager Workstations

AXIG.book  Page 49  Monday, December 5, 2005  12:43 PM
Text for E-Mail This option determines the file format that AppXtender Document 
Manager will use when e-mailing text pages. By selecting As text, 
AppXtender Document Manager will e-mail pages as text and 
exclude all annotations except redactions. Redactions cause the area 
where the redaction is located to be blank. By selecting As image, 
AppXtender Document Manager will e-mail text pages as TIFFs 
regardless of the image e-mail settings and include all annotations.

Use Multi-Page Files
for E-Mail

You can combine sequential pages that are similar or of the same file 
type and send them by e-mail as a combined file attachment or as a 
sequence of combined file attachments with the Use multi-page files 
option. For example, a document composed of a GIF, a TIFF, two 
PDFs, and three JPEGs (in that order) would be combined into three 
files: a TIFF, a PDF, and another TIFF. The first TIFF would contain 
the GIF and TIFF, the PDF would contain the two PDFs, and the 
second TIFF would contain the three JPEGs.

AppXtender can combine up to 1024 TIFF pages into a single attachment. For 
example, if you send a document that contains 1025 consecutive TIFF pages, 
one attachment contains the first 1024 consecutive TIFF pages and another 
attachment contains the remaining TIFF page.

The following table details which file types can be combined and how 
they are combined: 

Table 2-5 File Types and Combined Output

File Types Output When Combined

All supported image files, including: 
• TIFF
• GIF
• Bitmap
• PCX
• DCX
• JPEG
• TGA

1 TIFF file for each sequence of image pages in the document

The number of pages that can be combined into 1 TIFF file is limited to 
1024. If there are more than 1024 pages in the document, the 
combined files are broken up so that each file has no more than 1024 
pages in it.

Adobe Portable Document Format 
(PDF) files

1 PDF file for each sequence of PDF pages in the document

Text files, including: 
• TXT files
• AppXtender Reports Mgmt reports

1 TXT file for each sequence of text pages in the document (if the TXT 
file type was configured on the Configuration File Types tab in 
AppXtender Document Manager when the document was created); 
otherwise 1 TXT file for each TXT page in the document
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When the Use multi-page files option is disabled, pages of the same 
type are not combined. If you send a document by e-mail when this 
option is disabled, each page of the document is a separate 
attachment to the e-mail message. 

E-mail in Archived
Format

The Email in Archived format option allows you to send the archived 
format of each page by e-mail. That is, instead of specifying that 
images be sent as Windows BMP, Windows BMP Compressed, GIF, 
JPEG, TIFF, or TIFF Compressed, you can specify that pages be sent 
in the same format in which they were stored in the AppXtender 
system. A page can be sent in its archived format only when both of 
the following conditions are true: 

◆ The current user has sufficient privileges to hide all of the 
redactions on the page (if there are any).

◆ The page to be sent is not a certain kind of subpage. (If a subpage 
number appears after the BIN file name in the Information dialog 
box for the page to be sent, it can not be sent in its archived 
format. For instructions on displaying the Information dialog box, 
see the "Viewing Documents" chapter of the ApplicationXtender 
Document Manager User's Guide.)

If these conditions are true, the archived format of the page is always 
sent. If these conditions are not true, the page is sent as specified with 
other format options on the E-mail tab.

For example, if you have the image storage format for black and 
white images set to TIFF on the Data tab of the Configuration dialog 
box, and you import a black and white image into AppXtender, it is 
stored in TIFF format. If you enable the Use archived format option 
on the E-mail tab, and you send the same image from AppXtender 
(and the conditions above are met), it is sent as TIFF. 

Rich Text Format (RTF) files 1 RTF file for each RTF page in the document

HTML files 1 HTML file for each HTML page in the document

AppXtender-supported foreign file 
types, including: 
• Word processing files
• Spreadsheets
• Presentations

1 file for each file in the document

Table 2-5 File Types and Combined Output (continued)

File Types Output When Combined
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When the archived format of a page is sent by e-mail, no annotations are 
included on that page.

You can use this option to allow images to be sent in their original 
format. That is, if an image is imported into AppXtender and sent 
from AppXtender, the format of the sent image is exactly the same as 
the original image before import. A page can be sent in its original 
format only when all of the following conditions are true (in addition 
to the conditions above):

◆ The image storage format for the image type on the Data tab of 
the Configuration dialog box was set to Default when the image 
was imported.

◆ The Separate multi-page TIFFs option on the Data tab of the 
Configuration dialog box was disabled when the image was 
imported.

◆ The page to be sent is not text. (Text is always compressed before 
storage.)

If these conditions are true, the original format of the page is always 
sent. 

E-Mail Vendor This option configures the e-mail package that will be used by 
AppXtender Document Manager. You can choose from either 
Microsoft (MAPI32) or CC: Mail (SMI32).
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Export Tab
The Export tab of the AppXtender Document Manager Configuration 
dialog box provides options for exporting AppXtender documents 
and pages. AppXtender Document Manager can export documents 
and pages in the system to various file formats. (The Export tab is not 
available on the AppXtender Image Capture Configuration dialog 
box.) 

Figure 2-24 Configuration Dialog Box: Export Tab

For instructions on exporting documents, refer to the "Managing 
Documents" chapter of the ApplicationXtender Document Manager 
User’s Guide. 

Black & White 
Images for Export

This option determines the file format that AppXtender will use for 
images. Select a file format from the Black & white images 
drop-down list. Your choices are Windows BMP, TIFF, and TIFF 
Compressed.

4/8-bit Color 
Images for Export

This option determines the file format that AppXtender will use for 
4/8-bit color images. Select an appropriate file format from the 
4/8-bit color images drop-down list. Your choices are Windows BMP, 
Windows BMP Compressed, GIF, TIFF, and TIFF Compressed.
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True Color Images 
for Export

This option determines the file format that AppXtender will use 
when exporting true color images. Select an appropriate file format 
from the True color images drop-down list. Your choices are 
Windows BMP, GIF, JPEG, TIFF, and TIFF Compressed.

You can compress true color images using Joint Photographic Experts Group 
(JPEG) image compression. If you select JPEG, the JPEG quality factor (1-100) 
is enabled. For more information, see JPEG Quality Factor (1-100) on 
page 2-54.

JPEG Quality Factor
(1-100)

JPEG provides compression of true color images, such as 
photographs, artwork, and similar still images. There is always some 
loss of information when you use JPEG compression to compress an 
image. For example, when compressing a scanned photograph, the 
output image is not identical to the input image.

JPEG compression allows you to trade off between file size and 
output image quality. In most cases, you want to obtain a minimum 
file size by choosing the maximum amount of compression without 
affecting the output image quality. However, if image quality is not 
important, you can use a higher compression level to make an 
extremely small file. Conversely, if the image quality is important, 
you can use a lesser compression level to increase the quality until 
there is no visible change to the output image.

The JPEG quality factor (1-100) slider allows you to choose the 
compression setting for true color images. AppXtender uses the JPEG 
quality factor scale, which ranges from 1 to 100, where 1 indicates the 
smallest file size with the lowest quality and 100 indicates the largest 
file size with the best quality. 
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Figure 2-25 Configuration Dialog Box: Export Tab: JPEG Quality Factor

To set the level of JPEG compression for exported images: 

1. On the Export tab of the Configuration dialog box, select JPEG 
from the True color images drop-down list. The JPEG Quality 
Factor (1-100) slide ruler becomes available.

2. Use the slide ruler on the scale to adjust (reduce or increase) the 
level of compression and the quality factor that AppXtender 
applies to True color images when they are exported.

3. Click OK to save the settings.

Text for Export This option determines the file format that AppXtender will use 
when exporting text pages. By selecting As text, AppXtender will 
export pages as text and exclude all annotations except redactions. 
Redactions cause the area where the redaction is to be blank in the 
exported page. If you select As image, AppXtender will export text 
pages as TIFFs (regardless of the image export settings) and include 
all annotations. 

Use Multi-Page Files 
for Export

You can combine sequential pages that are similar or of the same file 
type and export them as a combined file or as a sequence of combined 
files with the Use multi-page files option. For example, a document 
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composed of a GIF, a TIFF, two PDFs, and three JPEGs (in that order) 
would be combined into three files: a TIFF, a PDF, and another TIFF. 
The first TIFF would contain the GIF and TIFF, the PDF would 
contain the two PDFs, and the second TIFF would contain the three 
JPEGs. 

AppXtender can combine up to 1024 TIFF pages into a single file. For 
example, if you export a document that contains 1025 consecutive TIFF 
pages, one file contains the first 1024 consecutive TIFF pages and another file 
contains the remaining TIFF page.

Files can be combined for export in the same way that they can be 
combined for e-mail. For detailed information on how files are 
combined, see Use Multi-Page Files for Export on page 2-55.

When the Use multi-page files option is disabled, pages of the same 
type are not combined. If you export a document when this option is 
disabled, each page of the document is exported as a separate file. 

Export in Archived 
Format

The Export in Archived format option allows you to export the 
archived format of each page. That is, instead of specifying that 
images be exported as Windows BMP, Windows BMP Compressed, 
GIF, JPEG, TIFF, or TIFF Compressed, you can specify that pages be 
exported in the same format in which they were stored in the 
AppXtender system. A page can be exported in its archived format 
only when both of the following conditions are true: 

◆ The current user has sufficient privileges to hide all of the 
redactions on the page (if there are any).

◆ The page to be exported is not a certain kind of subpage. (If a 
subpage number appears after the BIN file name in the 
Information dialog box for the page to be exported, it can not be 
exported in its archived format. For instructions on displaying the 
Information dialog box, see the "Viewing Documents" chapter of 
the ApplicationXtender Document Manager User's Guide.)

If these conditions are true, the archived format of the page is always 
exported. If these conditions are not true, the page is exported as 
specified with other format options on the Export tab.

For example, if you have the image storage format for black and 
white images set to TIFF on the Data tab of the Configuration dialog 
box, and you import a black and white image into AppXtender, it is 
stored in TIFF format. If you enable the Use archived format option 
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on the Export tab, and you export the same image from AppXtender 
(and the conditions above are met), it is exported as TIFF. 

When the archived format of a page is exported, no annotations are included 
on that page.

You can use this option to allow images to be exported in their 
original format. That is, if an image is imported into AppXtender and 
exported from AppXtender, the format of the exported image is the 
same as the original image before import. A page can be exported in 
its original format only when all of the following conditions are true 
(in addition to the conditions above):

◆ The image storage format for the image type on the Data tab of 
the Configuration dialog box was set to Default when the image 
was imported.

◆ The Separate multi-page TIFFs option on the Data tab of the 
Configuration dialog box was disabled when the image was 
imported.

◆ The page to be exported is not text. (Text is always compressed 
before storage.)

If these conditions are true, the original format of the page is always 
exported. 
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File Types Tab
The File Types tab of the Configuration dialog box provides options 
for importing files into AppXtender. By default, files not natively 
supported by AppXtender (for example, files other than TIFF, 
Windows bitmaps, TGA, RTF, JPEG, GIF, PCX, and DCX) are 
imported as foreign files. (For details on what file types are natively 
supported, refer to the "Getting Started" chapter of the 
ApplicationXtender Document Manager User’s Guide.) Pages imported 
as foreign files are represented in AppXtender Document Manager in 
one of the following two ways: 

◆ Represented by an icon and require a third-party viewer to 
display the contents of the page

◆ Displayed in the Verity KeyView Viewer (For more information, 
see Use KeyView to Display Foreign Files on page 2-26.)

For example, if a Microsoft Word document is imported (using the 
Import File function) as a new page, a Word icon displays as the 
AppXtender page. You then double-click the icon to start Word and 
view the document. The File Type tab provides options for importing 
file types or extensions. 

Figure 2-26 Configuration Dialog Box: File Types Tab
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AppXtender supports different file types in a variety of ways.

◆ Microsoft Word documents can be brought into AppXtender as 
OLE Objects, in which case the File Types settings do not matter. 
File Types settings apply only when a document or page is 
brought into AppXtender using the Import File command. 
(AppXtender Image Capture does not support OLE Objects.) 

◆ AppXtender does not support progressive JPEGs. Importing a 
progressive JPEG into AppXtender results in the file being 
imported as a foreign file.

◆ By default, most text pages are imported into AppXtender as 
plain text, but some may be imported as foreign files. If you want 
to import all files with a TXT extension as plain text, add this file 
type in the File Types tab. 

Adding File Types The File Types tab of the Configuration dialog box allows you to 
configure AppXtender Document Manager to recognize files by their 
extensions as certain file types. For example, you can configure 
AppXtender Document Manager to recognize files with the TXT 
extension as the Text file type.

To add a file type: 

1. In the File Extension text box, type the extension that you want 
AppXtender Document Manager to recognize.

2. Select a file type from the File Type drop-down list. The File Type 
options available are Image Format, Text, Rich Text Format, 
Embedded Object, Foreign File, Web Component, and Adobe 
PDF.

3. Click Add. The extension and file type are added to the Formats 
list.

4. Click OK to save the settings.

Deleting File Types The File Types tab of the Configuration dialog box allows you to 
remove extensions from the list of recognized file types.

To delete a file type: 

1. In the Formats list, select the file type you want to delete.

2. Click Delete. The file type is removed from the Formats list.

3. Click OK to save the settings.
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Data Tab
Some of the options on the AppXtender Document Manager 
Configuration dialog box Data tab are not available on the 
AppXtender Image Capture Configuration dialog box Data tab, 
because they configure features that are not available in AppXtender 
Image Capture.

◆ The Data tab of the AppXtender Image Capture Configuration 
dialog box allows you to set default image formats and other 
data-related settings. 

◆ The Data tab of the AppXtender Document Manager 
Configuration dialog box allows you to set AppXtender 
Document Manager index options, set default image formats, and 
other data-related settings. 

Figure 2-27 Configuration Dialog Box: Data Tab

Enable Dual Data 
Entry

The Enable dual data entry option on the Data tab works in 
conjunction with the Dual Data Entry flag configured in AppXtender 
AppGen. This option is enabled by default. (Dual Data Entry options 
are not available in AppXtender Image Capture.) 
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In order for dual data entry to be available for an index field, your system 
administrator must first enable the Dual Data Entry flag for that field in 
AppXtender AppGen. For more information, consult your AppXtender 
system administrator or refer to the "Application Design Reference" 
appendix of the ApplicationXtender Core Components Administrator’s Guide.

The Dual Data Entry flag and the Enable dual data entry option 
together form a validation measure that ensures documents are 
indexed correctly. When this feature is enabled, you must enter an 
index field’s data twice. AppXtender Document Manager accepts the 
information upon verification of the second entry. 

If the information entered the second time is the same as the first 
time, the document is indexed and added to the application. If the 
information is not entered correctly, a Dual Data Entry Error dialog 
box appears. 

If an Auto Index table is used to enter a value into an index field, even if that 
field is flagged for dual data entry, the user is not prompted to enter data a 
second time. For more information on importing data into an Auto Index 
table, consult your AppXtender system administrator or refer to the "Import 
Wizards" appendix of the ApplicationXtender Core Components Administrator’s 
Guide. For more information on using an Auto Index table to enter a value 
into an index field, consult your AppXtender system administrator or refer to 
the "Using Auto Index to Index Documents" section of the 
ApplicationXtender Document Manager User’s Guide. 

To activate dual data entry: 

1. During application generation in the AppXtender AppGen, apply 
the Dual Data Entry flag to each index field that requires the 
validation feature. 

2. In AppXtender Document Manager, in the Configuration dialog 
box, click the Data tab.

3. Make sure that the Enable dual data entry option is enabled. (This 
option is enabled by default.)

4. Click OK to save the settings.

Disable Query 
Window

This option allows AppXtender system administrators to control 
what queries are run in AppXtender. This option limits access to the 
Query view on the AppXtender Document Manager workstation. 
(Query options are not available in AppXtender Image Capture.) 
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This option is intended for systems where the AppXtender SDK has 
been used to set up access to AppXtender from another interface. You 
can use this option to force users to run queries from another 
interface instead of AppXtender.

Database Connect 
& Drop

This option controls the duration of the database connection held by 
AppXtender Document Manager. By default, the Database connect & 
drop option is disabled. 

◆ If this option is disabled, the AppXtender Document Manager 
data layer holds the connection to the underlying database for the 
entire AppXtender Document Manager session. 

◆ If this option is enabled, the AppXtender Document Manager 
data layer connects to the database when needed and then drops 
the connection when it is not needed. 

Because the user is connecting to the database and then dropping the 
connection when it is not needed, if the database goes down and back 
up or if the database fails over in a clustered server environment, 
AppXtender Document Manager connects to the restarted database 
or the new database. However, because users are connecting and 
dropping, there is performance degradation when this option is 
enabled (because database connect and drop depends on the data 
source’s ability to perform connection pooling).

If you are planning to run AppXtender Document Manager in a 
clustered environment, you must enable the Database connect & drop 
option. For more information on clustering, refer to the "Using 
AppXtender with a Clustered Environment" section of the 
ApplicationXtender Concepts and Planning Guide. 

Check for Matching 
Index

If this option is enabled, AppXtender Document Manager will 
automatically check existing documents for a duplicate index. This 
option allows the same index value or combination of index values to 
be entered for more than one document in an application. (Index 
options are not available in AppXtender Image Capture.) 

ODMA Support Use this option to activate the Open Document Management API 
(ODMA) integration between AppXtender-supported ODMA client 
applications and AppXtender. By enabling this option, users of 
AppXtender-supported ODMA client applications can easily store 
and retrieve documents within AppXtender without leaving an 
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active client application. (ODMA options are not available in 
AppXtender Image Capture.) 

Allow Remember 
Password

This option controls the display of the Remember password option 
on the Login dialog box for AppXtender Document Manager or 
Image Capture. By default, the Allow remember password option is 
enabled. The following table indicates the result of enabling or 
disabling the Allow remember password option on the AppXtender 
Document Manager or Image Capture Configuration dialog box: 

Prompt for Check 
Out when Open

This option controls the operational mode of AppXtender for the 
AppXtender Document Manager workstation. If this option is 
enabled, the AppXtender Document Manager workstation operates 
in check in/check out mode. If the option is disabled, the 
AppXtender Document Manager workstation operates in normal 
mode. In check in/check out mode, users are prompted to either 
check out a document or open it in read-only mode when they 
display the document. In AppXtender Document Manager normal 
mode, users can check out documents if needed, but they are not 
required to do so to make changes to a document (as long as the 
document is not checked out to someone else). (Options for 
document check-out are not available in AppXtender Image 
Capture.)

When a user checks a document out, AppXtender makes a separate 
working copy of the document. Any changes made to the document 
while the user has it checked out are made to the copy. If the user 
decides to check the document back in, the working copy is saved as 

Table 2-6 Allow Remember Password Option

Option 
Status

Configuration Dialog 
Box Result

Enabled AppXtender Document 
Manager 

The next time you start AppXtender Document Manager, the Login 
dialog box appears with the Remember password option. 

Enabled AppXtender Image 
Capture 

The next time you start AppXtender Image Capture, the Login dialog 
box appears with the Remember password option. 

Disabled AppXtender Document 
Manager 

The next time you start AppXtender Document Manager, the Login 
dialog box appears without the Remember password option. 

Disabled AppXtender Image 
Capture 

The next time you start AppXtender Image Capture, the Login dialog 
box appears without the Remember password option. 
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either a new document revision or a replacement document revision 
of the original document. If the user decides to cancel changes, the 
working copy is discarded by AppXtender.

When AppXtender is in check in/check out mode, use of revision 
control with AppXtender documents is mandatory. A user must 
check out a document to modify it. If the user does not check the 
document out, it is opened in read-only mode and it cannot be 
modified.

When AppXtender Document Manager is in normal mode, users can 
open and modify documents without checking them out. When a 
user closes a document, the modifications are automatically saved to 
the AppXtender document repository. Users can check out 
documents while AppXtender is in normal mode, to prevent other 
users from making modifications while they are working on a 
document. This is useful if making the document modifications will 
extend past the current user session.

If a user checks out a document and another user accesses that 
document while in normal mode, the second user automatically 
receives the AppXtender repository copy of the checked out 
document in read-only mode and is not able to make changes to the 
document until it is checked back in. 

A similar option in AppXtender AppGen enables check in/check out 
mode on an application basis, rather than a workstation basis. If you 
need to configure your AppXtender system to comply with the 
Health Insurance Portability and Accountability Act of 1996 
(HIPAA), it is recommended that you enable check in/check out 
mode on an application basis. For more information on configuring 
AppXtender to comply with HIPAA, refer to the "Entering 
Application Information" section of the ApplicationXtender Core 
Components Administrator’s Guide. 

The AppXtender Workflow tab has a related option called Check out 
document when opening and check in when closing. This option 
allows you to automatically check out a document when you open it, 
and check it back in when you close it. If this option is enabled, 
documents that are checked in or out are automatically given a 
timestamp as a check-in or check-out comment. For more 
information, refer to the ApplicationXtender Workflow User’s Guide.

Enable ODMA 
Attribute Search

When a user creates an AppXtender document using an 
ODMA-compliant application, the user can enter optional 
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information about the document: title, subject, author, keywords, and 
comment. These pieces of information, including the name of the user 
that created the document, are considered to be the document’s 
"ODMA attributes." These attributes can be changed once a 
document has been created. ODMA attributes (document properties) 
can be changed either within AppXtender or within the 
ODMA-compliant application that was used to create it. You can 
configure an AppXtender Document Manager workstation to allow 
users to use these ODMA attributes to retrieve documents. (ODMA 
options are not available in AppXtender Image Capture.) 

To allow users to search by ODMA attributes: 

◆ Enable the Enable ODMA attribute search option.

To prevent users from searching by ODMA attributes: 

◆ Disable the Enable ODMA attribute search option.

Auto Logout You can configure the AppXtender Document Manager workstation 
to automatically log out of AppXtender Document Manager after a 
specified period of idle time. An idle workstation is one on which the 
pointer and cursor have not been moved over any AppXtender 
interface, no dialog boxes or messages have appeared, and the 
current user is not logged onto any active data source as SYSOP. (The 
Auto Logout option is not available in AppXtender Image Capture.) 

To configure Auto Logout: 

◆ In the Auto Logout text box, specify the number of minutes that 
you want to allow an AppXtender Document Manager 
workstation to remain idle. (The maximum number of minutes 
that you can enter is 480.) When that time is up, the user is 
automatically logged out of AppXtender Document Manager.

To disable Auto Logout: 

◆ In the Auto Logout text box, type 0 (zero).

Data Field 2 Digit 
Year Max Future 
Years Setting

When a date has been stored in a two-digit date format, AppXtender 
Document Manager interprets the date in the context of a range of 
one hundred years. For example, in the context of the range 1910 to 
2009, AppXtender Document Manager interprets the year 08 as 2008 
instead of 1908.

AppXtender Document Manager calculates the end of this range by 
adding the number that you specify in the Max Future Years Setting 
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text box to the current year. For example, if the current year is 2005 
and you specify the value 25, AppXtender Document Manager 
would interpret each two-digit date in the context of the range 
1931-2030. This option applies only to two-digit date formats. 

It is not necessary to update this option each year, because 
AppXtender Document Manager calculates the range of years based 
on the current year. To continue the previous example (in which you 
have specified 25 in the Max Future Years Setting text box), in the 
year 2006, AppXtender Document Manager would interpret each 
two-digit date in the context of the range 1932-2031. 

The default value for the Max Future Years Setting is 10. If you use 
the default value of 10, in the year 1999, AppXtender Document 
Manager would interpret any two-digit year between 00 and 09 as 
2000-2009 respectively. AppXtender Document Manager would 
interpret any date between 10 and 99 as 1910-1999. 

Image Storage 
Format

You can configure the default storage format for AppXtender 
Document Manager image files. These settings determine the storage 
format for documents, batches, and pages created from scanning. 

These settings also determine to what storage format imported 
documents, batches, and pages are converted. This applies to all 
document imports, such as creating a new document, batch, or page 
using the Import File command; using the Index Image Import 
wizard and an import file that precedes each image file name with 
two "@" symbols (@@); creating a new document or page from a 
fax-in queue; and so on.

Storage Format for
Black & White Images

This option determines the file format that AppXtender Document 
Manager uses to store bi-tonal images. Select an appropriate file 
format from the Black & White drop-down list. Your choices are 
Default, TIFF, and Windows BMP: 

◆ If you select Default on the Configuration dialog box, imported 
bi-tonal images are stored in their native format (for example, a 
GIF file would be stored as GIF) and scanned bi-tonal images are 
stored as TIFF. 

◆ If you select one of the specific image formats on the 
Configuration dialog box, all bi-tonal images are stored in that 
format, regardless of their original format. 

Storage Format for
4/8-bit Color Images

This option determines the file format that AppXtender Document 
Manager uses for 4/8-bit color images. Select an appropriate file 
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format from the 4/8-Bit Color drop-down list. Your choices are 
Default, TIFF, and Windows BMP: 

◆ If you select Default, imported 4/8-bit color images are stored in 
their native format (for example, a GIF file would be stored as 
GIF) and scanned 4/8-bit color images are stored as TIFF. 

◆ If you select one of the specific image formats, all 4/8-bit color 
images are stored in that format, regardless of their original 
format. 

Storage Format for
True Color Images

This option determines the file format that AppXtender Document 
Manager uses to store true color images. Select an appropriate file 
format from the True Color drop-down list. Your choices are Default, 
TIFF, Windows BMP, and JPEG. 

◆ If you select Default, imported true color images are stored in 
their native format (for example, a GIF file would be stored as 
GIF) and scanned true color images are stored as TIFF. 

◆ If you select one of the specific image formats, all true color 
images are stored in that format, regardless of their original 
format. 

You can compress true color images using Joint Photographic Experts Group 
(JPEG) image compression. If you select JPEG, JPEG compression is enabled. 
You can set the JPEG Quality Factor (1-100) slider to control the level of 
compression and the quality of the compressed images. For more information 
on compressing images using this slider, see JPEG Quality Factor (1-100) on 
page 2-67.

JPEG Quality Factor (1-100)
JPEG provides compression of true color images, such as 
photographs, artwork, and similar still images. There is always some 
loss of information when you use JPEG compression to compress an 
image. For example, when compressing a scanned photograph, the 
output image is not identical to the input image.

JPEG compression allows you to trade off between file size and 
output image quality. In most cases, you want to obtain a minimum 
file size by choosing the maximum amount of compression without 
affecting the output image quality. However, if image quality is not 
important, you can use a higher compression level to make an 
extremely small file. Conversely, if the image quality is important, 
you can use a lesser compression level to increase the quality until 
there is no visible change to the output image.
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The JPEG quality factor (1-100) slider allows you to choose the 
compression setting for true color images. AppXtender Document 
Manager uses the JPEG quality factor scale, which ranges from 1 to 
100, where 1 indicates the smallest file size with the lowest quality 
and 100 indicates the largest file size with the best quality. 

Figure 2-28 Configuration Dialog Box: Data Tab: JPEG Quality Factor

To set the level of JPEG compression for stored images: 

1. On the Data tab of the Configuration dialog box, select JPEG from 
the True color images drop-down list. The JPEG Quality Factor 
(1-100) slide ruler becomes available. 

2. From the True Color drop-down list, select JPEG.

3. Use the slide ruler on the scale to adjust (reduce or increase) the 
level of compression and the quality factor that AppXtender 
Document Manager applies to True Color images when they are 
stored.

4. Click OK to save the settings.
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Separate Multi-Page
TIFFs

This option controls how AppXtender Document Manager imports a 
multi-page TIFF or multi-page DCX file. 

◆ If this option is enabled, AppXtender Document Manager 
imports a multi-page TIFF or multi-page DCX file by separating 
each page of the imported file into a page within the new 
document or batch. Each page is stored as a separate BIN file. 

If you enable this option, file storage format for multi-page image 
files depends on the image storage format settings discussed 
above (for black and white, 4/8-bit color, or true color settings). If 
this option is enabled, AppXtender Document Manager applies 
the selected image storage format (for example, BMP) to each 
stored page separated from the multi-page file. If this option is 
enabled and the image storage format is set to Default, all 
multi-page image files are saved in the file’s native format. 

◆ If this option is disabled, AppXtender Document Manager 
imports a multi-page TIFF or multi-page DCX file in its native 
format, regardless of the image storage format settings discussed 
above. All of the pages in the multi-page file are stored together 
as one BIN file. Disabling this option greatly increases the speed 
at which system conversion is completed. 
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Paths Tab
The Paths tab of the Configuration dialog box allows you to configure 
local and personal write paths for the AppXtender Document 
Manager workstation. These are separate from the write paths 
established in AppXtender AppGen for the application. You may also 
enter volume label search drive(s) for the AppXtender Document 
Manager workstation. This setting tells AppXtender Document 
Manager to look at the specified drives for the images. 

Figure 2-29 Configuration Dialog Box: Paths Tab

Path settings are saved in the Windows registry for each AppXtender 
Document Manager workstation. Whether you configure path 
settings on the Paths tab in the AppXtender Image Capture 
Configuration dialog box, or in the AppXtender Document Manager 
Configuration dialog box, the settings are saved to the same place in 
the registry and apply only to the workstation where the 
configuration takes place.

Local Write Path Using this option, you can activate a temporary storage area for 
scanning in AppXtender Document Manager, such as a local hard 
drive. You can even configure a different local write path for each 
data source. If you index documents when scanning locally in 
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AppXtender Document Manager, the index information is stored in 
the AppXtender application just as if you had scanned to the primary 
document write path, except the images are stored locally. The Local 
Write Path option enables you to use the local write path when 
needed and the document write path at other times. When this option 
is enabled, documents are stored in the path entered in the Local 
Write Path text box. 

CAUTION!
Do not enable a local write path on the AppXtender Document 
Manager workstation where the AppXtender Index Server is 
installed. If a local write path has been configured and enabled 
when you attempt to start the AppXtender Index Server, an error 
message appears and the AppXtender Index Server automatically 
shuts down. 

The Local Write Path option should be enabled when scanning locally. The 
option remains enabled until you clear the check box in the Paths tab of the 
Configuration dialog box.

You cannot use volume labels for the local write path.

You can use AppXtender Move Online to move locally scanned 
documents to the document write path. For instructions on using 
AppXtender Move Online, refer to the "AppXtender Move Online" 
appendix of the ApplicationXtender Document Manager User’s Guide or 
the ApplicationXtender Image Capture User’s Guide. 

Personal Search 
Path

Using this option, you can configure additional paths to search for 
AppXtender documents or batches. If documents or batches for an 
application are stored in a location that is not referenced in any of the 
other path settings, a personal search path should be set to allow for 
retrieval of those documents or batches. 

When retrieving documents or batches, AppXtender Document 
Manager searches first in the primary search path, then the 
application’s write path, and then the paths listed in the Personal 
Search Path text box. AppXtender Document Manager then searches 
all the remaining configured write paths. 
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Volume Label 
Search Drives

The Paths tab of the Configuration dialog box allows you to specify 
the drives that AppXtender Document Manager searches to find 
documents or batches that were stored on removable media using 
volume labels.

If removable media with volume labels are used as document write 
paths to store documents or batches, this option is used to configure 
retrieval of those documents or batches. The drive letter (or letters) 
where the media will be mounted must be specified as Volume Label 
Search Drives. AppXtender Document Manager checks each of the 
drives specified to determine if the media labeled with the volume 
label is mounted in one of those drives. If not, AppXtender Document 
Manager prompts the user to insert the appropriate media.

To specify a drive: 

1. You have the following choices: 

• In the Volume Label Search Drive(s) text box, type the drive 
letter. (To specify multiple drives, type each drive letter 
separated by a semicolon.)

• Click Select. Select a drive. (To specify multiple drives, hold 
down the [CTRL] key or [SHIFT] key while selecting the 
drives.) 

2. Click OK to save the settings.

Business 
Intelligence 
Gateway Path

The Paths tab of the Configuration dialog box allows you to configure 
the path for submitting documents/reports to BI Gateway. (This path 
is not available in the AppXtender Image Capture Configuration 
dialog box because it configures a feature that is not necessary in 
AppXtender Image Capture.) This path must be configured before 
submission to BI Gateway is allowed. For more information, refer to 
the ApplicationXtender Document Manager User’s Guide. 

To specify a BI Gateway path:

1. In the Business Intelligence Gateway path text box, type the path 
to the location where the ERMX.INI file was stored by 
AppXtender Reports Mgmt.

2. Click OK to save the settings.
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Full Text Tab
The Full Text tab of the AppXtender Document Manager 
Configuration dialog box provides options for full-text indexing. The 
following is an explanation of the Full Text tab options that are 
available for your use. (The Full Text tab is not available on the 
AppXtender Image Capture Configuration dialog box, because it 
configures features that are not necessary in AppXtender Image 
Capture.) 

Figure 2-30 Configuration Dialog Box: Full Text Tab

Processing Queue Use this option to choose the queue that will be used to process 
full-text indexing jobs. Full-text queues are created in the 
AppXtender Index Server Configuration dialog box or in 
AppXtender Queue Manager and can be selected at any AppXtender 
Document Manager workstation. Select the queue you want to use 
from the Processing Queue drop-down list.

When considering which queues to assign to each workstation, keep in mind 
that you cannot use more than one AppXtender Index Server for the same 
AppXtender application.
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Allow Full-Text Using this option, you can make all full-text commands unavailable 
to an AppXtender Document Manager workstation. This option may 
be useful when, for example, you are configuring a workstation for a 
user who does not need to use full text and you have a limited 
number of full-text licenses. If this option is enabled for an 
AppXtender Document Manager workstation when a user logs in to 
that workstation, a full-text license is used.

To make all Full-Text commands unavailable on an AppXtender 
Document Manager workstation: 

1. Disable the Allow full-text option.

2. Restart AppXtender Document Manager. The full-text commands 
are now unavailable on this workstation.

Convert to Text (if 
necessary)

When this option is enabled, all image pages that you submit to the 
AppXtender Index Server for full-text indexing are automatically 
processed using optical character recognition (OCR). When this 
option is not selected, you must use OCR to process an image page 
before you can submit it. In addition, when the OCR option is not 
selected, only text pages can be submitted to the AppXtender Index 
Server.

When you submit an image to the AppXtender Index Server for full-text 
indexing, if the OCR (if necessary) option is enabled and if the image does 
require OCR processing, the result of the OCR processing is automatically 
plain text, regardless of the OCR Result Format configuration on the OCR 
tab. 

Prompt User with 
Queue Selection

When this option is selected, AppXtender Document Manager will 
prompt you to pick a full-text queue every time a job is submitted to 
the AppXtender Index Server. Disabling this option will result in 
every full-text index job being submitted to the queue selected in the 
Processing Queue drop-down list.

Submit New 
Documents for Full 
Text Index

When this option is enabled, all new documents (that are imported or 
scanned into AppXtender) are automatically submitted to the 
AppXtender Index Server for full-text indexing. When the document 
is saved and closed, a message appears indicating that the full text 
index job has been submitted to the AppXtender Index Server. For 
instructions on configuring the AppXtender Index Server, consult 
Full Text Tab 2-73



2

2-74

Configuring AppXtender Document Manager Workstations

AXIG.book  Page 74  Monday, December 5, 2005  12:43 PM
your AppXtender system administrator or refer to the 
ApplicationXtender Index Server Administrator’s Guide. For instructions 
on creating a document, refer to the "Creating Documents" chapter of 
the ApplicationXtender Document Manager User’s Guide. 
ApplicationXtender Desktop Installation Guide



2
Configuring AppXtender Document Manager Workstations

AXIG.book  Page 75  Monday, December 5, 2005  12:43 PM
OCR Tab
The OCR tab of the AppXtender Document Manager Configuration 
dialog box contains options for using optical character recognition 
(OCR) with AppXtender. (The OCR tab is not available on the 
AppXtender Image Capture Configuration dialog box, because it 
configures features that are not available in AppXtender Image 
Capture.) 

Figure 2-31 Configuration Dialog Box: OCR Tab

OCR Engine Using this option, you can choose the OCR engine to be used by 
AppXtender. The "FineReader OCR Engine" option is always 
available as an OCR engine. (FineReader 6.0 OCR Engine is always 
installed with AppXtender Document Manager.) Other options are 
available only if you have purchased, installed, and configured the 
following products:

◆ If you have purchased, installed, and configured FineReader 7.0 
Scripting Edition, the "FineReader 7" option becomes available.

◆ If you have purchased, installed, and configured FormReader 6.5, 
the "FormReader 6.5" option becomes available.
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Figure 2-32 Configuration Dialog Box: OCR Tab: OCR Engines

When you select FineReader 7 or FormReader 6.5 as the OCR Engine, 
other options become available. For more information, see Text View 
on page 2-80, Export on page 2-80, and Indexing on page 2-81.

Allow OCR Using this option, you can make all OCR commands unavailable to 
an AppXtender Document Manager workstation. This option may be 
useful when, for example, you are configuring a workstation for a 
user who does not need to use OCR.

To make all OCR commands unavailable on an AppXtender 
Document Manager workstation: 

1. Click the Allow OCR check box to disable the option.

2. Restart AppXtender Document Manager. The OCR commands 
are now unavailable on this workstation.

OCR Result Format Using this option, you can choose the OCR output file format. When 
you use OCR to process documents or pages in AppXtender, they are 
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stored in the selected file format. Select either Plain text (TXT), or 
Rich text format (RTF). The following table explains each file format.

If Rich text format is selected, documents processed using OCR cannot be 
indexed using OCR proofing. Only plain text documents can be indexed 
using OCR Proofing. 

Template Settings If you have installed FineReader 7.0 Scripting Edition and have 
selected FineReader 7 as the OCR engine, or if you have installed 
FormReader 6.5 and have selected FormReader 6.5 as the OCR 
engine, you can configure the FineReader/FormReader template that 
AppXtender uses when you process an image with OCR. 

Adding a Template To add a template: 

1. Create a template in FineReader (.BLK file) or FormReader (.FRM 
file). Make sure that the field names in the template match the 
field names in the AppXtender application. For more information 
on creating a template in FineReader or FormReader, refer to your 
FineReader or FormReader documentation.

2. On the OCR tab of the Configuration dialog box, click Template 
Settings. The OCR Form Templates dialog box appears.

Figure 2-33 OCR Form Templates Dialog Box

Table 2-7 OCR Result Format Options

Option Description

Plain text (TXT) The plain text format is an ASCII text format, readable on MS-DOS/Windows operating 
systems. Plain text format retains formatting options that are available in MS-DOS text format, 
such as bold and italics.

Rich text format 
(RTF) 

Rich text format is a format that can be read on all platforms. This format should be used if the 
document text will be exported for use on non-MS-DOS/Windows systems. Rich text format 
retains most formatting.
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3. Click Add. The Add OCR Forms Template dialog box appears.

Figure 2-34 Add OCR Forms Template Dialog Box

4. In the Template File text box, enter a path and file name for a 
FineReader or FormReader template file (.FRM). 

5. In the Template Description text box, type a description for the 
form template. This description is for identification purposes.

6. Click OK. The form template is added to the list of form 
templates.

Configuring a
Template

To configure a template: 

1. Click Template Settings. The OCR Form Templates dialog box 
appears.

Figure 2-35 OCR Form Templates Dialog Box

2. Select a form template and click Set Default.

3. If you want a list of form templates as you process each image 
using OCR, enable the Show list selection before form OCR 
option.

4. Click Close.

Language Selection The Language Selection drop-down list allows you to select from a 
variety of languages. Selection of a language that matches the images 
to be processed improves the results of OCR processing. For example, 
if you select Spanish, the results of OCR processing will be better for 
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images of Spanish text than for images of English text. The language 
selection in the OCR tab of the Configuration dialog box sets the 
default for the workstation. The languages that are available for 
selection depend on the OCR engine you chose.

Text View If you have installed FineReader 7.0 Scripting Edition and have 
selected FineReader 7 as the OCR engine, or if you have installed 
FormReader 6.5 and have selected FormReader 6.5 as the OCR 
engine, you can use the Enable proofing and Use form templates 
options. The Enable proofing option configures AppXtender to 
enable OCR proofing when a text view is created. The Use form 
templates option configures AppXtender to use the selected template 
when a text view is created. 

If the Use form templates option is enabled for exporting OCR 
results, the text view contains only the text specified by the template. 
Otherwise, the text view contains all of the text on the image. 

Export If you have installed FineReader 7.0 Scripting Edition and have 
selected FineReader 7 as the OCR engine, or if you have installed 
FormReader 6.5 and have selected FormReader 6.5 as the OCR 
engine, you can use the Enable proofing and Use form templates 
options. The Enable proofing option configures AppXtender to 
enable OCR proofing during export. The Use form templates option 
configures AppXtender to use the selected template during export. 

If the Use form templates option is enabled for exporting OCR 
results, the exported file contains only the text specified by the 
template. Otherwise, the exported file contains all of the text on the 
image. For more information on OCR exporting, see OCR Job on 
page 2-81.

Indexing If you have installed FineReader 7.0 Scripting Edition and have 
selected FineReader 7 as the OCR engine, or if you have installed 
FormReader 6.5 and have selected FormReader 6.5 as the OCR 
engine, you can use the Enable proofing option. The Enable proofing 
option configures AppXtender to enable OCR proofing during 
indexing. 

OCR Job The following topics describe the two ways that you can configure 
OCR jobs.
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Processing Queue Use this option to choose the queue that will be used to process OCR 
jobs. OCR queues can be created in the AppXtender Index Server 
Configuration dialog box or in AppXtender Queue Manager and can 
be selected at any AppXtender Document Manager workstation. 
Select the queue you want to use from the Processing Queue 
drop-down list. (For more information on creating an OCR queue, 
consult your AppXtender system administrator or refer to the 
ApplicationXtender Index Server Administrator’s Guide.)

Prompt User with
Queue Selection

When this option is selected, AppXtender Document Manager 
prompts the user to select an OCR queue each time a job is submitted 
to the AppXtender Index Server. Disabling this option results in 
every OCR job being submitted to the queue selected in the 
Processing Queue drop-down list.
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Fax-in Tab
The Fax-in tab of the AppXtender Document Manager Configuration 
dialog box allows you to choose a Fax-in server. (The Fax-in tab is not 
available on the AppXtender Image Capture Configuration dialog 
box, because it configures features that are not necessary in 
AppXtender Image Capture.) 

Figure 2-36 Configuration Dialog Box: Fax-in Tab

To configure the Fax-in tab: 

◆ From the Select Fax-in Server drop-down list, select the server 
that you want to use. AppXtender supports each of the following 
Fax-in servers: 

• Castelle FAX Press Server (Software Version 8.0.0/8.1.0) 

• RightFax (Software Version 9.0) 

If you select RightFax, everything that you need to connect to the FAX server 
is included in AppXtender Document Manager. If you select a version of the 
Castelle FAX Press Server, the Castelle FAX Press client must be installed on 
the workstation. The Castelle FAX Press client is not included with 
AppXtender Document Manager.
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If you select RightFax, you can customize the way columns appear in fax 
server queue dialog boxes, which list each incoming or outgoing fax from a 
selected queue. Customizable options include column title, column order, 
which columns appear, and the type of faxes that appear. To modify these 
options, open the RFFIELDLIST.INI file, which is located in the C:\Program 
Files\XtenderSolutions\Content Management\ directory (or wherever 
AppXtender Desktop was installed), in Notepad and follow the instructions 
in the file to edit it. 
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Thumbnail Tab
The Thumbnail tab of the AppXtender Document Manager 
Configuration dialog box allows you to configure the Thumbnail 
view. (The Thumbnail tab is not available on the AppXtender Image 
Capture Configuration dialog box.) 

Figure 2-37 Configuration Dialog Box: Thumbnail Tab

The following table describes each option on the Thumbnail Tab: 

Table 2-8 Thumbnail Tab Options

Option Description

Thumbnail Width (pixels) Allows you to specify the width of the thumbnails, in pixels. You can choose from 
48, 64, 80, 96, and 128.

Thumbnail Height (pixels) Allows you to specify the height of the thumbnails, in pixels. You can choose from 
48, 64, 80, 96, and 128.

Color Depth Allows you to specify the color depth of the thumbnails. You can choose from any 
of the color depths available for your monitor, including 16-Color, 256-Color, and 
True Color, up to 24-Bit Color. The color depth 16-Color is enough for most 
thumbnails.
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Render foreign file Allows you to display thumbnails of foreign files as miniature images, rather than 
as icons. To display the thumbnail of a foreign file as a miniature image, you must 
also have the foreign file configured to display as an image, rather than as an 
icon.

Render RTF File Allows you to display thumbnails of Rich Text Format (RTF) files as miniature 
images, rather than as icons. 

Hide annotation if allowed to 
do so

Allows you to hide annotations on thumbnail images. You must have the Edit 
Annotations privilege to use this option.

3D Icon Allows you to display thumbnails as a three-dimensional icon.

Display thumbnail of the 
document when double-click 
on a query result.

Allows you to display the Thumbnail view instead of the Document Display view 
when you double-click a record in the Result Set.

Always display the thumbnail 
of the active document.

Allows you to keep the Thumbnail view displayed, regardless of other activity on 
the AppXtender Document Manager window. The Thumbnail view changes to 
reflect the currently displayed document.

Table 2-8 Thumbnail Tab Options (continued)

Option Description
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Document Signing Tab
The Document Signing tab of the Configuration dialog box allows 
you to specify a digital certificate and comment to be used by default 
when documents are signed. This tab is available only for 
applications in which the Document signing option has been enabled. 

Figure 2-38 Configuration Dialog Box: Document Signing Tab

For more information, see the following topics:

◆ Importing Digital Certificates on page 2-87

◆ Exporting Digital Certificates on page 2-88

◆ Specifying a Default Digital Certificate on page 2-88

◆ Clearing Default Digital Certificate on page 2-88

◆ Deleting Digital Certificates on page 2-89
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Importing Digital 
Certificates

Import a digital certificate on each AppXtender Document Manager 
workstation that will be used to sign AppXtender page versions. 

To import digital certificates:

1. On the Document Signing tab, click Import. The Import 
Certificate dialog box appears.

Figure 2-39 Import Certificate Dialog Box

2. Specify the certificate file to import. (You can click Browse to 
locate the file.)

3. Specify the password for the private key. 

4. Specify whether you want the certificate file to be available only 
for the current user or for any user on the computer. 

5. Specify whether you want to enable strong private key 
protection. 

6. Specify whether you want the certificate to be exportable.

7. Click OK.

8. On the Document Signing tab, click OK.
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Exporting Digital 
Certificates

To export a certificate:

1. On the Document Signing tab, click Export. The Export Certificate 
dialog box appears. 

Figure 2-40 Export Certificate Dialog Box

2. Specify the certificate file to export. (You can click Browse to 
locate the file.)

3. Specify the password for the private key. 

4. Click OK.

Specifying a Default 
Digital Certificate

To specify a default certificate and comment:

1. On the Document Signing tab, select the certificate that you want 
to designate as default.

2. Click Set As Default. The default comment text box becomes 
available.

3. In the default comment text box, type the comment that you want 
to include each time a document is signed.

4. On the Document Signing tab, click OK.

Clearing Default 
Digital Certificate

To clear the default certificate designation:

1. On the Document Signing tab, select the default certificate.

2. Click Clear. 

3. On the Document Signing tab, click OK.
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Deleting Digital 
Certificates

To delete a certificate from configuration:

1. On the Document Signing tab, select the certificate that you want 
to delete. 

2. Click Delete. A message appears asking you to confirm the 
deletion. 

3. Click Yes.

4. On the Document Signing tab, click OK.
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Workflow Tab
AppXtender Workflow is an AppXtender add-on module. The 
Workflow tab of the AppXtender Document Manager Configuration 
dialog box contains various options that enable you to use 
AppXtender Workflow in conjunction with AppXtender Document 
Manager. (The Workflow tab is not available on the AppXtender 
Image Capture Configuration dialog box.)

For details on configuring the Workflow tab and on using 
AppXtender Workflow, refer to the ApplicationXtender Workflow User’s 
Guide.
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Saving and Loading Settings
To make AppXtender system deployment easier for you, Save 
Settings and Load Settings features allow you to copy workstation 
settings from one AppXtender Document Manager workstation to 
another. You (or the user) customize the configuration of the 
AppXtender Document Manager workstation in several ways, and 
then you save the configuration. To copy the saved configuration to 
other workstations, you then just load the saved settings file on each 
workstation and all of the saved configuration settings are applied. 
The following topics detail the settings that are saved and explain 
how to save and load settings. 

The Save Settings and Load Settings features are not available in AppXtender 
Image Capture. 

Saving Settings Once the AppXtender Document Manager workstation has been 
configured, you can save the customized settings to a configuration 
file. The saved settings file can be loaded on other AppXtender 
Document Manager workstations to copy the saved configuration 
settings to those workstations. 

If a profile is created in one version of AppXtender, this profile cannot be 
applied to later versions of AppXtender. You must save a new settings file for 
each AppXtender release.

When you save settings for a workstation, AppXtender saves 
information about all of the options in the Configuration dialog box. 
When you load the settings on another workstation, the settings you 
saved are loaded for that workstation. If an option is enabled on the 
workstation where the settings are saved, the option is enabled on the 
other workstation once you load the settings. 

In addition to Configuration dialog box options, Save Settings saves 
information about the views and toolbars on the AppXtender 
Document Manager window. If, for example, Allow Docking is 
enabled for the Query view on the workstation where you save 
settings, Allow Docking is enabled on the AppXtender Document 
Manager window of the second workstation once you load settings.

Additional information saved when you save settings includes 
default settings for annotations, the data source configurations on the 
ApplicationXtender Desktop Installation Guide



2
Configuring AppXtender Document Manager Workstations

AXIG.book  Page 91  Monday, December 5, 2005  12:43 PM
AppXtender Document Manager workstation, and the last directories 
used for several AppXtender Document Manager functions. For 
details on setting AppXtender annotation defaults, refer to the 
ApplicationXtender Document Manager User’s Guide. For more 
information on setting up AppXtender data sources, refer to the 
ApplicationXtender Core Components Guide. 

For a detailed list of the settings that are saved, see Saved Workstation 
Settings on page 2-95.

To save a workstation settings file: 

1. Make the appropriate changes to the Configuration settings, 
annotation defaults, data source configuration, and window 
arrangement. 

2. Select Save Settings from the File menu. The Save AppXtender 
Document Manager Settings dialog box appears. 

Figure 2-41  Save AppXtender Document Manager Settings Dialog Box

3. If you want to specify the type of file you are saving, from the 
Save as type drop-down list, select the type of files that you want 
to save. Your available choices are AppXtender Document 
Manager Settings Files (*.AXS) or All Files (*.*).

4. Select the location to save the file. You can select the location from 
the Save in drop-down list and double-click a folder or file in the 
box below to open it, or enter a path and file name. 

5. You also have the following options: 
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• To save the AppXtender Document Manager workstation 
configuration settings, leave the AppXtender Document 
Manager Settings check box enabled. Enabling this option 
saves all AppXtender Document Manager configuration 
settings, toolbar configuration, views, and status bar settings.

• To save data source settings, leave the XSCM.Config check box 
enabled. For more information, see Important Information about 
XSCM.CONFIG on page 2-93. 

• To save settings from an AppXtender integration with 
Microsoft Outlook, such as targets and field mappings, enable 
the Outlook check box. (For information on the Outlook for 
AppXtender integration, refer to the Microsoft Outlook 
Integration for ApplicationXtender Integration Guide.) 

6. Click Save. The file is saved in the specified location.

Important 
Information about 
XSCM.CONFIG

When you use AppXtender Admin, Component Registration, Data 
Source Selector, or web service, settings are read from and written to 
C:\Documents and Settings\All Users\Application 
Data\XSCM.CONFIG. Each component writes different settings to 
this file. 

CAUTION!
Do not edit or distribute the XSCM.CONFIG file. 

The recommended method for providing each user with access to a 
data source group is to have each user use the AppXtender Data 
Source Selector to locate a data source, as described in the 
ApplicationXtender Document Manager User’s Guide.

However, the XSCM.Config file check box on the Load AppXtender 
Document Manager Settings dialog box and the Save AppXtender 
Document Manager Settings dialog box provides another method for 
distributing data source connectivity. When you save workstation 
settings with the XSCM.Config file check box selected, the contents of 
the XSCM.CONFIG file are included in the AppXtender Document 
Manager settings file. The contents of the XSCM.CONFIG file are 
located at the end of the AppXtender Document Manager settings file 
starting with line [XSCM.CFG]. The AppXtender Document Manager 
settings file can be distributed to other AppXtender Document 
Manager workstations. When your users load an AppXtender 
Document Manager settings file that has an [XSCM.CFG] section in it, 
with the XSCM.Config file check box selected, a new XSCM.CONFIG 
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file is created. Each user is then prompted to log in to the default data 
source, as specified in the new XSCM.CONFIG file. 

CAUTION!
If you choose to use this method for distributing data source 
connectivity, you must take both of the following precautions:

◆ Ensure that AppXtender Admin, Component Registration, Web 
Server, Rendering Server, and web services have not been 
installed on any of the computers on which you intend to save or 
load the AppXtender Document Manager workstation settings.

◆ Ensure that no changes are made in AppXtender Admin or 
Component Registration on any computer in your AppXtender 
system between saving and loading AppXtender Document 
Manager workstation settings.

If problems occur after deployment on an AppXtender Document 
Manager workstation, use the AppXtender Data Source Selector to 
locate a data source, as described in the ApplicationXtender Document 
Manager User’s Guide. If problems occur after deployment on a 
workstation with AppXtender Web components, run AppXtender 
Component Registration to register components again as described in 
the ApplicationXtender Web Access Administrator’s Guide. 
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Saved Workstation 
Settings

The following table lists the settings that are saved when you save 
settings for an AppXtender Document Manager workstation: 

Table 2-9 Saved Workstation Settings

AppXtender Document 
Manager Configuration Saved Settings

AppXtender Document 
Manager Window 
Configuration

• The tab of the Configuration dialog box that was most recently viewed
• The data source set as the active data source (shown in bold in the 

Application view)
• The application set as the active application (shown in bold in the 

Application view)
• Allow Docking option for the Application view
• Allow Docking option for the Query view 
• Allow Docking option for the Thumbnail view
• Allow Docking option for the AppXtender Workflow Workbox
• Hide On Use option for the Application view
• Hide On Use option for the Query view
• Hide On Use option for the AppXtender Workflow Workbox
• Float as MDI Window option for the Application view
• Float as MDI Window option for the Query view
• Float as MDI Window option for the Thumbnail view
• Float as MDI Window option for the AppXtender Workflow Workbox
• New Document Index view location
• Modify Document Index view location
• Batch Index view location
• Batch Index view column settings
• Display of Enhance Image dialog box

Annotation Settings • Foreground color
• Background color
• Line width
• List of most recently used rubber stamp annotations for each 

AppXtender application
• Default annotation group for each data source

Toolbars • For all toolbars: 
Small icons 
Large icons

• For each toolbar: 
Display location
Whether the toolbar is hidden
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Query Result Set column 
Configuration

• The settings for result set column display in the result set for each 
application 

View Tab Configuration • Image Size
Fit to window
Fit to window height
Fit to window width
Actual size
Use zoom setting

• Zoom settings are pixels
• Display text view of page
• Scale-to-gray
• Restore last layout at startup
• Use KeyView to display foreign files
• Allow map of unknown data sources to existing data sources

Display Tab Configuration • Screen DPI
Vertical
Horizontal

• Maximum Query Results
• Sort result set automatically
• Sort Order of Document ID 

Ascending Order 
Descending Order

• PgUp/PgDn in dual-page view 
Next/previous 2 pages
Next/previous page

Fonts Tab Configuration • Screen Fonts
• Printer Fonts
• Simulate Box Drawing Characters

Enable Support for Form Text
Enable Support for Data Text

Scan Tab Configuration • Remove blank pages (and Threshold)
• Synchronized scan
• Scanner manual feed timeout

Table 2-9 Saved Workstation Settings (continued)

AppXtender Document 
Manager Configuration Saved Settings
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COLD Tab Configuration • Cache forms
• Allow paste text
• Allow zoom
• Display as image only
• Form Overlay Settings

Screen
Printer

• Default Color Bar settings
Show
Lines 
Color 

Print Tab Configuration • Print original size
• Dithering
• Toolbar Print Button
• Acceleration 

None
XipPrint
Talaris
Quick PCL

• Endorsement
Endorse printed pages
Position
Text

OCR Tab Configuration • OCR Engine
• Allow OCR
• OCR Result Format
• Template Settings
• Language Selection 
• Text View

Enable proofing
Use form templates

• Export
Enable proofing
Use form templates

• Indexing
Enable proofing

• Processing Queue
• Prompt user with queue selection on submit

Table 2-9 Saved Workstation Settings (continued)

AppXtender Document 
Manager Configuration Saved Settings
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Fax-in Tab Configuration • Select Fax-in Server

Thumbnail Tab Configuration • Thumbnail Width (Pixels)
• Thumbnail Height (Pixels)
• Color Depth
• Render foreign file
• Render RTF file
• Hide annotation if allowed to do so
• 3D icon
• Display thumbnail of document when double-click result set
• Always display the thumbnail of the active document

Workflow Tab Configuration • Workflow Server Name
• Workflow Database Name
• Use AppXtender user name and password for login
• Always open latest revision

Document Signing Tab 
Configuration

• Default certificate
• Default comment

E-Mail Tab Configuration • Black &White Images Format
• Pseudo Color Images Format
• True Color Images Format

JPEG Quality Factor
• Text Format
• Use multi-page files
• Vendor 

Microsoft (MAPI32)
CC: Mail (SMI32)

Export Tab Configuration • Black &White Images Format
• Pseudo Color Images Format
• True Color Images Format

JPEG Quality Factor
• Text Format
• Use multi-page files

File Types Tab Configuration • File types that have been added and their associated file extensions

Table 2-9 Saved Workstation Settings (continued)

AppXtender Document 
Manager Configuration Saved Settings
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Data Tab Configuration • Enable dual data entry
• Disable query window
• Database connect & drop
• Check for matching index
• ODMA support
• Allow remember password
• Prompt for checkout when open
• Enable ODMA Attribute Search
• Auto Logout 
• Date Field with 2-digit Year Max Future Years Setting
• Image Storage Format
• Black & White
• 4/8-Bit Color
• True Color
• Separate multi-page TIFFs
• JPEG Quality Factor

Paths Tab Configuration • Local write path use
• Local write path
• Personal search path
• Volume label search drives

Table 2-9 Saved Workstation Settings (continued)

AppXtender Document 
Manager Configuration Saved Settings
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Loading Settings When you choose Load Settings from the File menu, AppXtender 
Document Manager displays the Load AppXtender Document 
Manager Settings dialog box. This dialog box allows you to load 
previously saved configuration settings on an AppXtender 
Document Manager workstation. The settings consist of the 
AppXtender Document Manager settings that are found in the 
Configuration dialog box, toolbar configuration, AppXtender 
Document Manager views, and status bar settings, user data source 
settings, and system data source settings.

When you attempt to open AppXtender Document Manager, if a message 
appears indicating that AppXtender cannot find the data source or licensing 
information it needs to connect to the AppXtender database, you can load 
settings to provide AppXtender with connection information. 

Full-Text Tab Configuration • Processing Queue
• Allow Full text
• Convert to text (if necessary)
• Prompt user with queue selection on submit
• Submit new documents for full text index

Directories • Last import directory
• Last export directory
• Last Batch Create directory
• Last Batch Import directory
• Last OCR export directory

Data Source Configuration • Default data source setting 
• Selected data sources
• For each data source: 

Description
Encoded data source connection string
Full-text queues
OCR queues
Print queues

Table 2-9 Saved Workstation Settings (continued)

AppXtender Document 
Manager Configuration Saved Settings
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To load a workstation settings file: 

1. From the File menu, select Load Settings. The Load AppXtender 
Document Manager Settings dialog box appears. 

Figure 2-42  Load AppXtender Document Manager Settings Dialog Box

2. Select the file name. You can select the appropriate folder from 
the Look In drop-down list and double-click a folder or file in the 
box below to open it, or enter a path and file name and click 
Open. 

3. Specify which settings are loaded from the file. You have the 
following choices: 

• To load the AppXtender Document Manager workstation 
configuration settings, leave the AppXtender Document 
Manager Settings check box enabled. Enabling this option 
loads all Configuration settings, toolbar configuration, 
AppXtender Document Manager views, and status bar 
settings.

• To load the data source settings, leave the XSCM.Config check 
box enabled. For more information, see Important Information 
about XSCM.CONFIG on page 2-93. 

• To load settings such as targets and field mappings from an 
AppXtender integration with Microsoft Outlook, enable the 
Outlook check box. (For information on the Outlook for 
AppXtender integration, refer to the Microsoft Outlook 
Integration for ApplicationXtender) 
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If AppXtender is having trouble connecting to the AppXtender database 
on your computer, you can copy the data source settings for a 
workstation that can successfully connect to the database and load the 
data source settings on your computer. If you choose not to load 
AppXtender Document Manager Settings when you load settings, you 
can load the data source configuration without affecting the rest of your 
AppXtender configuration. 

4. Click Open. The Login dialog box appears.

Your login procedure may vary depending on the security provider in 
use for the current data source. For information, refer to the 
ApplicationXtender Core Components Administrator’s Guide. 

You must re-login to AppXtender Document Manager to load the 
saved profile.

5. In the User Name text box, type a user name that is valid for the 
default data source. 

6. In the Password text box, type your password. 

7. Click Login. AppXtender resets your AppXtender Document 
Manager workstation to the new workstation profile settings.

If AppXtender is unable to connect to the database, check the database to 
make sure that it is running and accessible. 
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A

Maintaining the
AppXtender Desktop

Installation
Invisible Body Tag

The following sections describe how to modify, repair, or remove an 
AppXtender Desktop installation:

◆ Modifying an AppXtender Desktop Installation .........................A-2
◆ Repairing an AppXtender Desktop Installation...........................A-4
◆ Uninstalling AppXtender Desktop 5.30.........................................A-5
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Modifying an AppXtender Desktop Installation
This section describes how to modify an AppXtender Desktop 
installation. These instructions may be necessary if you need to use a 
component of AppXtender that was not included during the original 
installation. 

To modify an AppXtender Desktop installation:

1. Close all AppXtender components and ensure that the 
AppXtender Index Server is not running.

2. Obtain the installation files for AppXtender Desktop. You have 
the following choices:

• Download the Desktop_5.30.xxx.zip file from one of the 
following locations to a temporary directory on your 
computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. From the Windows Start menu, select Settings and then Control 
Panel. From the Control Panel menu, select Add/Remove 
Programs. The Add/Remove Programs dialog box appears. 
Select ApplicationXtender Desktop and click Change. 

The AppXtender Desktop setup wizard appears, beginning with 
the Application Maintenance page. 

4. Enable the Modify option and click Next. The Select Features 
page appears. 

5. Indicate which components you want to include and which 
components you want to exclude. For details, see Select Features 
Page on page 1-12. 

6. Click Next. The Ready to Modify the Application page appears.
ApplicationXtender Desktop Installation Guide
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7. Click Next. AppXtender Desktop begins the modification process. 
When AppXtender Desktop has been modified, the next page of 
the wizard indicates a successful installation.

8. Click Finish. 
Modifying an AppXtender Desktop Installation A-3
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Repairing an AppXtender Desktop Installation
This section describes how to repair an AppXtender Desktop 
installation. These instructions may be necessary if AppXtender 
Desktop files or registry keys have been deleted. 

To repair an AppXtender Desktop installation:

1. Close all AppXtender Desktop components and ensure that the 
AppXtender Index Server is not running.

2. Obtain the installation files for AppXtender Desktop. You have 
the following choices:

• Download the Desktop_5.30.xxx.zip file from one of the 
following locations to a temporary directory on your 
computer:

– The Documentum download center 
(https://documentum.subscribenet.com)

– The FTP site 
(ftp.emc.com\Software\AppXtender5.30\Desktop)

Extract the installer zip file to the temporary directory. If you 
download  multiple products, download all of them to the 
same temporary directory.

• Insert the AppXtender Desktop/Web setup CD-ROM into 
your CD-ROM drive.

3. From the Windows Start menu, select Settings and then Control 
Panel. From the Control Panel menu, select Add/Remove 
Programs. The Add/Remove Programs dialog box appears. 
Select ApplicationXtender Desktop and click Change. 

The AppXtender Desktop setup wizard appears, beginning with 
the Application Maintenance page. 

4. Enable the Repair option and click Next. The Ready to Repair the 
Application page appears.

5. Click Next. AppXtender Desktop begins the repair process. When 
AppXtender Desktop has been repaired, the next page of the 
wizard indicates a successful installation.

6. Click Finish. 
ApplicationXtender Desktop Installation Guide
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Uninstalling AppXtender Desktop 5.30
This section describes how to uninstall AppXtender Desktop 5.30. 
These instructions may be necessary when you upgrade from 5.30 to 
a later release.

To uninstall AppXtender Desktop 5.30:

1. Close all AppXtender components and ensure that the 
AppXtender Index Server is not running.

2. From the Windows Start menu, select Settings and then Control 
Panel. From the Control Panel menu, select Add/Remove 
Programs. The Add/Remove Programs dialog box appears. 
Select ApplicationXtender Desktop and click Change. 

The AppXtender Desktop setup wizard appears, beginning with 
the Application Maintenance page. 

3. Enable the Remove option and click Next. The AppXtender 
Desktop Uninstall page appears.

4. Click Next. AppXtender Desktop begins the uninstall process. 
When AppXtender Desktop has been uninstalled, the next page 
of the wizard indicates a successful uninstallation.

5. Click Finish. 

CAUTION!
Restart your computer before installing the latest release of 
AppXtender Desktop.
Uninstalling AppXtender Desktop 5.30 A-5
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Glossary

This glossary contains terms related to ApplicationXtender 
(AppXtender) components. Many of these terms are used in this 
manual.

A
accessible security Accessible security grants access to the users in the group for only 

documents with index field values matching the secured value list. 
(See also Document Level Security.)

annotation An annotation is a note or a shape added to a document or batch 
page, typically to focus attention on a particular part of the page. 
Users can use annotations to comment on the contents of a page, 
block areas of the page from view, or highlight important 
information. When a user creates an annotation, it is associated with 
the AppXtender page on which he or she created it. Annotations are 
edited and stored separately from the image, but they are displayed 
along with the image in ApplicationXtender Document Manager and 
Web Access. The types of annotations available include text, 
highlighting, lines, arrows, shapes, and rubber stamps.

annotation group Annotation groups allow you to create associations between users, 
groups, and specific annotations. You can specify which users and 
groups can view or modify specific annotations, and which users and 
groups can hide or modify specific redactions. 

appender An appender allows you to select the specific ApplicationXtender 
Web Access .NET or Rendering Server information you want to log 
and to publish that information to a specific reporting venue. 
ApplicationXtender Desktop Installation Guide 1
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application An AppXtender application is an index-driven data storage structure 
where documents can be stored and retrieved. An AppXtender 
application is based on an index that is composed of one or many 
fields. AppXtender applications are created in ApplicationXtender 
Application Generator (AppXtender AppGen).

application security
profile

Application security profiles, like global security profiles, allow you 
to grant a particular set of privileges to a user or group of users. You 
can define different privileges for a user or group of users in each 
application. 

When a profile is application-specific, however, the privilege settings 
are not carried over to a new application when it is created. If a group 
of users has an application-specific profile for a certain application, 
but no global profile, then when a new application is created, the 
members of the group will not be able to access the new application. 
Application-specific security settings override global security 
settings.

ApplicationXtender
Auto Index Import

AppXtender Auto Index Import allows use of the <F7> key to import 
index values from a text file, so users adding documents can 
automatically populate indexes using the imported data. Auto Index 
is ideal for the import of index records that are applicable to only one 
document. In an Auto Index Import table, once a record (or a group 
of index values) has been used to index a document, the record is 
deleted. 

ApplicationXtender
Index Image Import

AppXtender Index Image Import allows you to import index data 
and document files in a single step. A text file is required which 
contains a line of text for each document to be imported, with a value 
for each index field and a reference to the location of the file to be 
imported. No manual document indexing is required. 

ApplicationXtender
Index Server

ApplicationXtender Index Server is an optional module that adds 
full-text indexing and OCR functionality to AppXtender systems. 

ApplicationXtender
Key Reference Import

AppXtender Key Reference Import allows use of the <Tab> key to 
import index values from a text file. Key Reference is most effectively 
used in situations where each imported record may describe several 
documents. Key Reference Import maintains the index records in the 
Key Reference table even after records have been used to index 
documents. Any change made to a record in the Key Reference table 
is reflected in the indexes of all documents described by that record. 
ApplicationXtender Desktop Installation Guide
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audit trail The Audit Trails feature allows you to track user activity within the 
AppXtender system. System-wide activities such as the creation, 
modification, and deletion of applications, users, and groups can be 
tracked. You can also track user activity in applications by tracking 
items such as the creation and deletion of documents, the addition of 
pages, and the modification of index information for documents. By 
default, AppXtender logs audit trail events to a table in the 
AppXtender database. You can configure audit trails to log to this 
table, to a log file, or to both locations.

authentication Authentication requires all users to enter a valid user name and 
password to access software modules. Authentication ensures that 
each user is who he or she claims to be. 

authorization Authorization is the granting of specific access privileges according 
to the user name. Security profiles contain information pertaining to a 
user’s specific privileges within the AppXtender system. 

C
check in/check out

mode
When an AppXtender application or an AppXtender Document 
Manager workstation is in check in/check out mode, use of revision 
control with AppXtender documents is mandatory. Users must check 
out a document to modify it. If they do not check the document out, it 
is opened in read-only mode and it cannot be modified.

COLD COLD (computer output to laser disk) data is report data generated 
for existing applications. COLD data can be added to AppXtender as 
documents through the use of ApplicationXtender Reports 
Management (AppXtender Reports Mgmt). 

collection A collection is a Verity full-text database. 

D
data source A data source is the means by which AppXtender accesses data from 

a database. When a data source is defined, an OLE DB data provider 
is configured to access the database. All of these characteristics in 
combination – where the data is stored, the format of the data stored, 
and the data provider used to access the data – comprise the data 
source. 
ApplicationXtender Desktop Installation Guide 3



4

Glossary

AXIG.book  Page 4  Monday, December 5, 2005  12:43 PM
data source group A data source group in ApplicationXtender Administrator 
(AppXtender Admin) associates a list of data sources with everything 
that has been configured in AppXtender Admin, such as 
ApplicationXtender Web Access (AppXtender Web) settings and 
connections to License Server computers. This feature provides 
convenience in that the work of configuration does not have to be 
repeated every time you create a data source.

database A database is a collection of data tables of a particular database 
format (such as Oracle or Microsoft SQL Server). AppXtender uses 
databases to store application information. When an application is 
created, details such as the field definitions and security information 
are stored in database tables. Once documents are added to an 
application, index information is stored in a table, as are the pointers 
to the location of the documents. 

document A document is a page or group of pages stored in an application and 
identified by index information. Each page of a document is 
comprised of a single object such as a scanned image file or a word 
processing document. To create a new document, users add an object 
to an application and attach index information to it. Subsequent 
objects can be added as additional pages of the same document.

Document Level
Security

Document Level Security (DLS) pinpoints user access within an 
AppXtender application. With DLS, you can deny a group of users 
access to any classified or sensitive document(s), without restricting 
access to other documents in the application. DLS can also be 
configured to grant a group of users access to only a specific set of 
documents in an application. 

E
ERM ERM (enterprise report management) data is report data generated 

for existing applications. ERM data can be added to AppXtender as 
documents through the use of ApplicationXtender Reports 
Management (AppXtender Reports Mgmt). 

extended
applications

Extended applications are AppXtender applications that can be called 
from within other software applications, adding document storage 
and processing functions. 
ApplicationXtender Desktop Installation Guide
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F
full-text Users can index documents for full-text searching by submitting them 

to the AppXtender Index Server. With a full-text search, users can 
find documents even if they do not know any of the index values. 
Users can also use full-text searching to refine an index value search.

G
global security profile Global security profiles can be established to automatically assign a 

uniform set of access privileges for a user or group of users every 
time a new application is created. When a global profile exists for a 
user or group of users, the privileges assigned in that profile are 
automatically assigned for every application created. If a user or 
group of users does not have a global profile, an application-specific 
profile must be created for that user or group before they can access 
an application.

grab bar An AppXtender Document Manager docked view has a grab bar. A 
grab bar is similar to a title bar except that it does not contain a title. 

I
impersonation

account
The AppXtender Index Server impersonation account grants security 
privileges to AppXtender Index Server and is essential for the 
AppXtender Index Server to operate properly. AppXtender Index 
Server uses the AppXtender Index Server impersonation account to 
access remote and server resources, including AppXtender document 
paths, the License Server, the registry, and the image repository (in 
some cases, the DiskXtender Document Server). 

import specification A specification is a set of rules that AppXtender follows when 
importing data from an import file using the AppXtender Auto Index 
Import, Index Image Import, or Key Reference Import wizard. 

inaccessible security Inaccessible security denies access to the users in the group for 
documents with index field values matching the secured value list. 
(See also Document Level Security.)

index An AppXtender index contains a group of fields where descriptive 
information pertaining to documents can be stored. This group of 
field definitions is used by AppXtender when storing index 
information within an application.
ApplicationXtender Desktop Installation Guide 5
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J
JDBC Java Database Connectivity (JDBC) is a programming interface for 

accessing data in a Java 2 Edition application such as the 
ApplicationXtender Web Access J2 (AppXtender WebJ2) deployment 
model. For more information, refer to the ApplicationXtender Web 
Access J2 Administrator’s Guide. 

N
node A node is an element of a tree structure such as in AppXtender 

Admin, AppGen, Document Manager, or Reports Mgmt. A node can 
be expanded to reveal subnodes or can be collapsed. 

O
OCR Users can process bi-tonal images using optical character recognition 

(OCR). This process converts an image of text into text. After a user 
processes an image using OCR, it can then be submitted to the 
AppXtender Index Server for full-text searching.

ODMA Open Document Management API (ODMA) support allows users to 
work with AppXtender documents within other ODMA-compliant 
applications. 

OLE DB OLE DB is a programming interface for accessing data, and is a 
fundamental building block for storing and retrieving data using 
Microsoft’s Data Access Components (MDAC). OLE DB provides 
flexible data architecture that offers applications like AppXtender 
efficient access to databases. Data is accessed through OLE DB data 
providers

P
page The word “Page” typically implies a single entity. Since AppXtender 

supports multiple object types, the term “page” is redefined within 
AppXtender to mean a single object. A very long word processing file 
is considered a page to AppXtender. A page could also be, for 
example, a single scanned image, a 30-minute video clip, or an audio 
recording. Each page of a document has the same index record 
attached.
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privileges Privileges govern the ability of a user or group of users to access 
functions in AppXtender. 

R
redaction A redaction is a filled and opaque annotation shape that can be used 

to secure or hide portions of image and text pages. Users can apply 
redaction to all available annotations. When applied, the area of the 
page behind the redaction is not visible. 

S
security Security is the combination of authentication and authorization.

security mapping When AppXtender Migration is used to migrate documents and 
security information, the administrator has the option to map users 
and groups in the source database to users and groups in the 
destination database. Similarly, when the ApplicationXtender Media 
Distribution (AppXtender Distribution) Extraction Wizard is used to 
extract AppXtender documents and security information before the 
creation of an AppXtender Distribution CD-ROM, the administrator 
has the option to map users and groups in the source database to 
users and groups in the database on the CD-ROM (or in the database 
where the CD-ROM will be reintegrated).

security provider Security providers implement authentication, which requires all 
users to enter a valid user name and password to access most 
modules. AppXtender Admin offers two pre-packaged security 
providers (CM and Windows) to ensure that each user is who he or 
she claims to be. You can also create a directory service security 
provider, if necessary.

W
write paths Write paths are used to instruct AppXtender where to store 

documents, annotations, OCR output, and the ProIndex full-text 
database for a particular AppXtender application. 
ApplicationXtender Desktop Installation Guide 7
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4/8-bit color images

e-mail format  2-47
export format  2-53
storage format  2-66

A
acceleration printer options  2-43
Acrobat Reader

view PDF files  2-26
actual size display, as default  2-25
adding

file type  2-59
fine reader template  2-78
page numbers to printed documents  2-44
toolbar buttons  2-5

allowing
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full text on an AppXtender workstation  2-74
map of unknown data sources to existing  
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paste  2-38
remember password option  2-63
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AppXtender
configuring  2-1, 2-21
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AppXtender Desktop installation  1-6
completing  1-15
custom  1-12
license agreement  1-8
location  1-10
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starting  1-7
unattended  1-17
workstation type  1-10

AppXtender Image Capture
configuring  2-21

AppXtender Reports Mgmt documents
configuring  2-38
configuring form overlay  2-39
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customize  2-9
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docking  2-9
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archived format

e-mailing  2-50
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author, search by  2-64
auto logout  2-65
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B
band width, color bar  2-40
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from multi-page TIFF or DCX  2-69
bitonal images  2-47
black and white images

e-mail format  2-47
export format  2-53
storage format  2-66

buttons, toolbar
adding  2-5
change size  2-5
customizing  2-5
removing  2-5

C
cache forms  2-38
change toolbar button size  2-5
check out

prompt for when open  2-63
COLD data

configuring  2-38
configuring form overlay  2-39

collapse columns  2-18
color bar

color, setting  2-40
enabling for text  2-39, 2-40
width in lines, setting  2-40

color images
e-mail format  2-47
export format  2-53, 2-54
storage format  2-66, 2-67

column
hide in result set  2-16
order in result set  2-17
save in result set  2-18
show in result set  2-16
widths in result set  2-18

combining pages for
e-mail  2-49
export  2-55

comment, search by  2-64
compressing

e-mailed true color images  2-49
exported true color images  2-55
stored true color images  2-67, 2-68

configuration
dialog box  2-21
load  2-100

configuring
ApplicationXtender  2-1
AppXtender Document Manager 

workstation  2-21
AppXtender Image Capture workstation  

2-21
cache forms  2-38
COLD/ERM settings  2-38
data settings  2-60
display settings  2-28
document display  2-6
e-mail package  2-52
e-mail settings  2-46
export settings  2-53
fax in settings  2-82
file types  2-58
fine reader template  2-79
fonts  2-31
full-text settings  2-73
index options  2-60
local forms cache  2-38
OCR settings  2-76
paths  2-70
print original size  2-41
print settings  2-41
printer fonts for COLD documents  2-32
Quick Print feature  2-43
scaling  2-24
scanning  2-35
status bar  2-8
Talaris feature  2-43
thumbnails  2-84
title bar  2-6
view settings  2-24
workstation  2-1
workstations  1-10
XipPrint II feature  2-43
zoom  2-24

connection to database, maintaining  2-62
consistent installation  1-17
creator, search by  2-64
Customer support x
customize

AppXtender views  2-9
AppXtender window  2-3

customizing
toolbar buttons  2-5
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D
data

settings, configuring  2-60
data source

saved settings  2-20
unknown  2-27

database
maintaining connection  2-62

date
index values, Y2K compliance  2-65

DCX files
importing multi-page files  2-69

default
actual size  2-25
ascending order  2-30
descending order  2-30
fit left to right  2-25
fit to window  2-25
fit top to bottom  2-25
login (SYSOP)  1-28
storage format for 4/8-bit color images  2-67
storage format for bi-tonal images  2-66
storage format for images  2-66
storage format for true color images  2-67

definition of terms
grab bar  2-9

deleting
file type  2-59

demonstration
applications  1-25
database  1-25

descending order, as default  2-30
dialog boxes, display views as  2-11
display

as image only  2-39
status bar  2-8
toolbars  2-5

display settings, configuring  2-28
dithering  2-42
document

configure display  2-6
display  2-6

Documentation, related viii
DPI, screen  2-28
dropping database connection  2-62
dual data entry  2-60

E
electronic mail  2-46
e-mail  2-46

combining pages for  2-49
configuring  2-46
format  2-47
text format  2-55

e-mail format, 4/8-bit color images  2-47
e-mail format, black and white images  2-47
e-mail format, text  2-49
e-mail format, true color images  2-47
e-mail package

configuring  2-52
e-mail tab  2-46
e-mailing

archived format  2-50
original format  2-51

enable paste text  2-38
ERM data

configuring form overlay  2-39
ERM data, configuring  2-38
export

configuring settings  2-53
images  2-55

export format, 4/8-bit color images  2-53
export format, black and white images  2-53
export format, true color images  2-54
export tab  2-53
exporting

archived format  2-56
combined pages  2-55
OCR proofing during  2-80
original format  2-57

F
fax in settings, configuring  2-82
fax in tab  2-82
file type

adding  2-59
deleting  2-59

file type, configuring  2-58
fine reader template  2-78

configuring  2-79
fit

left to right, as default  2-25
fit to window
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as default  2-25
fit top to bottom

as default  2-25
float as MDI window  2-13
fonts

configuring  2-31
printer  2-32

fonts tab  2-31
foreign files

Verity KeyView Viewer  2-26
form overlay, settings  2-39
formats

e-mail  2-47, 2-55
OCR results  2-77

formats for e-mail
4/8-bit color images  2-47
black and white images  2-47
text  2-49
true color images  2-47

formats for export
4/8-bit color images  2-53
black and white images  2-53
true color images  2-54

formats for storage
4/8-bit color images  2-66
black and white images  2-66
true color images  2-67

forms, caching  2-38
full screen  2-14
full text

allow on an AppXtender workstation  2-74
full text tab  2-73
full-text  2-74
full-text queue

prompt user to select  2-74
full-text settings

configuring  2-73

G
grab bar, defined  2-9
grayscale, display as  2-25
green bar

enabling for text  2-39, 2-40

H
Help x

hide
result set columns  2-16
status bar  2-8

hide on use  2-14

I
image

compression for e-mailed  2-49
compression for exported  2-55
compression for stored  2-68
e-mail format, 4/8-bit color  2-47
e-mail format, black and white  2-47
e-mail format, true color  2-47
export format, 4/8-bit color  2-53
export format, black and white  2-53
export format, true color  2-54
size options  2-24
storage format, 4/8-bit color  2-66
storage format, black and white  2-66
storage format, true color  2-67

importing multi-page image files  2-69
index

check for matching  2-62
dual data entry  2-60

index options
configuring  2-60

indexing documents, using OCR template  2-81
installing

AppXtender  1-1
scanner drivers  1-24

J
job

OCR  2-81
JPEG compression  2-67
JPEG quality factor  2-47, 2-54

K
keyboard keys

logging in  1-28
Page Down  2-28
Page Up  2-28

KeyView Viewer
view foreign files  2-26

keyword, search by  2-64
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L
layout, restore previous  2-26
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engine  2-76
full text  2-74
job  2-81
output file format  2-77
tab  2-76

OCR queue
prompt user to select  2-81

OCR Result Format setting
workstation  2-74, 2-77

OCR settings
configuring  2-76

ODMA
support  2-62

ODMA attributes, search by  2-64
opening

AppXtender configuration  2-21
original format

e-mailing  2-51
exporting  2-57

original size, configuring  2-41
owner, search by  2-64

P
page

combining for e-mail  2-49
combining for export  2-55

Page Down key  2-28
page numbers

adding to printed documents  2-44
Page Up key  2-28
password

allowing remember password  2-63
remember option  1-29

paste
enabling  2-38
special  2-38

paths
configuring  2-70
local  2-70
personal search  2-71

PDF files
Acrobat Reader  2-26

personal search path  2-71
plain text  2-77

OCR format  2-78
print

dithering  2-42
endorsement feature  2-44
settings configuring  2-41

printer  2-39
acceleration option  2-43

printing
configure to print original size  2-41
configuring fonts for COLD documents  2-32
enable Quick Print feature  2-43
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enable XipPrint II feature  2-43

prompt for check out  2-63
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quality of JPEG images  2-67
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reordering the columns  2-17
resizing the columns  2-18
saving the columns  2-18
showing columns  2-16
sorting  2-17

queue
full-text jobs  2-73
OCR jobs  2-81

Quick Print feature
configuring  2-43

R
remember password  1-29
remember password, allowing  2-63
Remove Blank Pages  2-35
removing

toolbar buttons  2-5
reorder columns  2-17
repairing AppXtender Desktop installation  A-4
reset

result set columns  2-18
resize
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restore last layout at startup  2-26
result set
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save
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settings  2-91
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saved settings
data sources  2-20

scale to gray  2-25
scaling, configuring  2-24
scan

synchronized  2-37
scanner drivers, installing  1-24
scanner timeout

manual feed  2-37
scanning

configuration  2-35
scanning locally, local write path  2-71
screen  2-39

DPI  2-28
search by ODMA attributes  2-64
search drives  2-72
security provider selecting  1-29
selecting security provider  1-29
sending by e-mail

combined pages  2-49
separating multi-page image files  2-69
Service x
settings

FineReader template  2-78
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workstation, load  2-100, 2-101
workstation, save  2-91, 2-92

show
columns  2-16
status bar  2-8

Silent Setup  1-17
size
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result set  2-17
result set automatically  2-29

status bar
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summary of chapters  8-viii
support
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SYSOP
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Technical support x
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e-mail format  2-49
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paste  2-38
view  2-80

Threshold slider  2-36
thumbnail tab  2-84
thumbnails

configuring  2-84
TIFF, multi-page  2-69
timeout
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customizing  2-5

display  2-5
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true color images
e-mail format  2-47
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vendor  2-52
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view foreign files  2-26
view

options, full screen  2-14
view settings, configuring  2-24
view tab  2-24
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display as dialog box  2-11
display as subwindow  2-12
docking  2-9
hiding on use  2-13

volume label
search drives  2-72
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width in lines, color bar  2-40
wizards
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load settings  2-101
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write path
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XipPrint II feature
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